
    
What’s New
Pro Tools LE® and Pro Tools M-Powered™ 7.4



 

Legal Notices

 

This guide is copyrighted ©2007 by Digidesign, a division of 
Avid Technology, Inc. (hereafter “Digidesign”), with all rights 
reserved. Under copyright laws, this guide may not be 
duplicated in whole or in part without the written consent of 
Digidesign.

003, 003 Rack, 96 I/O, 96i I/O, 192 Digital I/O, 192 I/O, 
888|24 I/O, 882|20 I/O, 1622 I/O, 24-Bit ADAT Bridge I/O, 
AudioSuite, Avid, Avid DNA, Avid Mojo, Avid Unity, Avid Unity 
ISIS, Avid Unity MediaNetwork, Avid Xpress, AVoption, 
AVoption|V10, Beat Detective, Bruno, Command|8, Control|24, 
D-Command, D-Control, D-Fi, D-fx, D-Show, DAE, Digi 002, 
Digi 002 Rack, DigiBase, DigiDelivery, Digidesign, Digidesign 
Audio Engine, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiDrive, DigiRack, DigiTest, 
DigiTranslator, DINR, DV Toolkit, EditPack, Impact, Interplay, 
M-Audio, MachineControl, Maxim, Mbox, MediaComposer, 
MIDI I/O, MIX, MultiShell, OMF, OMF Interchange, PRE, 
ProControl, Pro Tools M-Powered, Pro Tools, Pro Tools|HD, 
Pro Tools LE, QuickPunch, Reel Tape, Reso, Reverb One, 
ReVibe, RTAS, Smack!, SoundReplacer, Sound Designer II, 
Strike, Structure, SYNC HD, SYNC I/O, Synchronic, TL Space, 
Velvet, and X-Form are trademarks or registered trademarks of 
Digidesign and/or Avid Technology, Inc. All other trademarks 
are the property of their respective owners.

Product features, specifications, system requirements, and 
availability are subject to change without notice.

PN 9320-56791-00 REV A 08/07

Comments or suggestions regarding our documentation?
email: techpubs@digidesign.com



   

contents

                                      
Chapter 1. Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

New Features in Pro Tools LE and Pro Tools M-Powered 7.4  . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Chapter 2. Elastic Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5

Example Elastic Audio Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

Elastic Audio Tracks  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Elastic Audio Analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Real-Time and Rendered Elastic Audio Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Elastic Audio Plug-ins  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Editing in Warp View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Editing in Analysis View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Tempo Changes and Tick-Based Elastic Audio Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Moving Elastic Audio Between Tracks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

Elastic Properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

AudioSuite Processing and Elastic Audio Regions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Fades and Microfades . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Elastic Audio in DigiBase Browsers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Elastic Audio in the Region List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Quantizing Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38
Contents iii



  

iv

                                    
Chapter 3. Miscellaneous Pro Tools Features and Enhancements . . . . . . . . . . . . . . .  41

Playback Engine Enhancements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

System Usage Window Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

New and Improved Preferences Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

General Session and Track Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Save Session Updates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47

Importing Tempo From Tick-Based Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Missing Rendered Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

DigiBase Enhancements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Language Compatibility Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52

Beat Detective Enhancement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

Tab to Transients Command Keyboard Shortcut  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  55

MIDI In with ReWire . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Pro Tools LE Hardware Support Enhancement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Chapter 4. Miscellaneous Pro Tools Video Enhancements and Features . . . . . . . . .  59

Avid Mojo SDI Support for Pro Tools LE. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

General Video-Related Improvements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64

Support for Windows Media Video (VC-1 AP Codec) Files . . . . . . . . . . . . . . . . . . . . . . . . . . .  64
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4



                   
chapter 1

Introduction
This chapter is an overview of new features in 
Pro Tools LE® and Pro Tools M-Powered™ 7.4 
for the following Digidesign-qualified systems 
on Windows or Mac OS X:

• 003™

• 003 Rack

• Digi 002®

• Digi 002 Rack™

• Mbox®

• Mbox 2

• Mbox 2 Pro

• Mbox 2 Mini

• Pro Tools M-Powered™

System Requirements
For complete system requirements, refer to the 
Digidesign website (www.digidesign.com).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it 
has tested and approved. 

For a list of Digidesign-qualified computers, 
operating systems, hard drives, and third-party 
devices, visit the Digidesign website 
(www.digidesign.com). 
New Features in Pro Tools LE 
and Pro Tools M-Powered 7.4
Pro Tools LE and M-Powered 7.4 include the fol-
lowing new or enhanced features:

Elastic Audio for Real-Time and Rendered Time 
Compression

• Elastic audio tracks:

• Real-time

• Rendered

• Optimized analysis and Time Compression 
and Expansion (TCE) algorithms for poly-
phonic, monophonic, and rhythmic material

• Varispeed resampling algorithm to link time 
and pitch changes

• Ability to automatically conform imported 
audio (AIFF, WAV, BWF, REX, and ACID files) 
from DigiBase to local session tempo

• Ability to automatically conform audio to 
tempo changes on tick-based Elastic Audio 
tracks

• New Track Views:

• Warp track view for detailed Elastic Audio 
editing

• Analysis track view for advanced Elastic 
Audio analysis editing

• Elastic Properties window for audio regions 
on Elastic Audio-enabled tracks
Chapter 1: Introduction 1
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• DigiBase support of Elastic Audio:

• Ability to preview files in DigiBase at the 
session tempo

• Ability to preview audio in DigiBase brows-
ers in tandem with session playback

• Elastic Audio plug-in selector for preview 
and import

• Create Elastic Audio Analysis command for 
batch analyzing files in DigiBase

• Clear Elastic Audio Analysis command

• Ability to quantize audio

Miscellaneous Pro Tools Features and 
Enhancements

• Playback Engine enhancements for Elastic Au-
dio and sampler instrument plug-ins (such as 
Structure):

• DAE Playback Buffer Size now includes val-
ues in milliseconds

• Cache Size for determining amount of 
memory DAE allocates to pre-buffer audio 
for playback and looping when using Elas-
tic Audio

• Plug-in Streaming Buffer Size for determin-
ing amount of memory DAE allocates for 
sample playback with sampler plug-ins

• “Optimize for Streaming Content” option 
for improved playback of sampler plug-in 
samples located on your audio drive

• Separate CPU (RTAS) and CPU (Elastic) meters 
in System Usage window

• New Editing preferences:

• Changes to Fades Editing preference

• New Warp/Notes Track View in Zoom Tog-
gle section
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
• New Processing preferences:

• Import REX Files as Region Groups prefer-
ence and Automatically Create Fades op-
tion

• Drag and Drop From Desktop Conforms to 
Session Tempo preferences

• Elastic Audio options

• General session, track, and plug-in features: 

• Click Setup menu command renamed to 
Click/Countoff

• Event Menu commands renamed

• Time Shift field (in Time Shift plug-in) re-
named to Speed

• Waveform height for new and imported 
tracks follows default waveform height set-
ting

• Save Session Copy In dialog updated with 
options to Limit Character Set and to not 
copy Elastic Audio Rendered Files

• Missing Files dialog updated with option to 
Regenerate Missing Rendered Files Without 
Searching

• Miscellaneous DigiBase features:

• Ability to toggle between Loop Preview and 
Normal Preview during file preview

• Preview button Right-click menu for pre-
viewing files

• Ability to preview one or both channels of 
a split stereo file

• Volume control for previewed files

• Meter display and clip indicators for pre-
viewed files

• Look Ahead typing for DigiBase searches



      
• Language compatibility features and en-
hancements: 

• Entry and display of any language charac-
ters supported in Unicode

• Ability to search across multiple languages 
in DigiBase

• New Display preference sets language for 
Pro Tools application, making it possible to 
run one language version on a different lo-
calized version of Windows

• New “Default Auto-Naming to English 
(ASCII)” preference

• New Text Encoding menu in Import Ses-
sion Data dialog, for identifying language 
encoding of legacy sessions

• Ability to choose language encoding used 
when saving session materials

• Database information for all languages 
now stored in a single Unicode folder

• Editing improvements:

• Beat Detective Enhanced Resolution gen-
eral analysis algorithm (Pro Tools LE or 
M-Powered with Music Production Toolkit 
only)

• Improved transient detection for Tab to 
Transients and Separate Region at Tran-
sients

• Tab to Transients command keyboard 
shortcut

• MIDI improvements: 

• MIDI In to Pro Tools over ReWire

• LE interface enhancements:

• On/off footswitch support (003, 003 Rack, 
Digi 002, Digi 002 Rack, and Mbox 2 Pro 
only)

• Ability to punch in and out with foot-
switch added to Mbox 2 Pro
Miscellaneous Video Enhancements and 
Features

Avid Mojo SDI Support for Pro Tools LE with 003 
or Mbox 2

• Support for Avid Video

• Support for video features previously only 
supported by Pro Tools HD and Pro Tools LE 
with DV Toolkit 2:

• Multiple video tracks in the Timeline 

• Multiple QuickTime movies on a single 
video track

• Multiple playlists for video tracks

• Multiple codecs on an individual video 
track

• Avid and QuickTime video track icons

• Ability to drag video files from the Region 
List to the Timeline

• Gaps Between Regions video import op-
tion, for indicating time between each im-
ported video clip in a video track

• General video editing

• Video region groups
Chapter 1: Introduction 3
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General Video-Related Improvements

• Expanded video resolution support for 
Pro Tools with Avid Mojo, including all video 
resolutions previously supported by Pro Tools 
with Avid Mojo SDI and AVoption|V10

• Support for co-installation of Avid Xpress Pro 
5.7.x with all versions of Pro Tools 7.4

• DigiTranslator support on Pro Tools M-Pow-
ered systems

• Support for Windows Media video created us-
ing the VC-1 Advanced Profile codec (Win-
dows Vista only):

• Import, playback, and general editing com-
mands

• Windows Media (VC-1 AP) track type icons 
on video tracks

• Bounce to Windows Media (VC-1 AP) 
movie

• Support for Windows Media (VC-1 AP) 
playback on dual monitors and/or to client 
monitor via DirectShow devices
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4



           
chapter 2

Elastic Audio
Pro Tools 7.4 introduces Elastic Audio for track-
based real-time Time Compression and Expan-
sion (TCE). Pro Tools Elastic Audio uses excep-
tionally high-quality transient detection algo-
rithms, beat and tempo analysis, and real-time 
TCE processing algorithms. Elastic Audio lets 
you quickly and easily tempo conform and beat 
match audio to the session’s Tempo ruler. It also 
provides an unprecedented degree of control 
over transient detection and TCE processing on 
an event-by-event basis.

With Elastic Audio, Pro Tools analyzes entire au-
dio files for transient “events.” For example, an 
event can be a drum hit, a sung note, or chord 
played by a guitar. These detected events can 
then serve as control points for “warping” the 
audio. Pro Tools can warp (TCE) audio events 
automatically, such as automatically conform-
ing audio to the session tempo or quantizing au-
dio events, or you can warp audio manually us-
ing the standard editing tools in the new Warp 
Track View.

Elastic Audio is useful in several common work-
flows: working with loops, correcting perfor-
mances, remixing, sound design and special ef-
fects, and film music and post production. 
Working with Loops

If you work with rhythmic loops, Elastic Audio 
lets you preview your loops in DigiBase browsers 
at their native tempo (BPM) or at the session 
tempo (BPM). You can even preview the loop 
while the session is playing back. When you 
find the loop you like, drag it from the browser 
and drop it into the session. The loop automat-
ically conforms to the session tempo map and 
Bar|Beat grid.

Correcting Performances

Elastic Audio lets you quantize audio to tighten 
up a performance or even manually re-align that 
one note that was played just a little late. Or, 
you might decide that the performance is excel-
lent, but just a little under tempo. Tick-based 
Elastic Audio automatically warps audio to con-
form to tempo changes. When you change your 
tracks to tick-based and increase the session 
tempo, the audio automatically time com-
presses to match.

Remixing

Elastic Audio lets you quickly beat match an en-
tire song to the session tempo and Bar|Beat grid. 
Chapter 2: Elastic Audio 5
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Sound Design and Special Effects

You can use Elastic Audio to achieve special ef-
fects with extreme or widely variable TCE. Use 
the Varispeed algorithm to achieve tape-like ef-
fects for speed and pitch change.

Film Music and Post Production

If you are scoring a film scene, use Elastic Audio 
to fit the music to the required duration. You 
can even use tempo changes to achieve acce-
lerandi and ritardandi. If you are doing post pro-
duction, use Elastic Audio to adjust for pull-up 
or pull-down factors.

Example Elastic Audio 
Workflow
In this workflow, you will be introduced to 
some common Elastic Audio tasks for working 
with loops:

• Create and configure a new session for this 
workflow.

• Locate and preview a loop in DigiBase at 
the session tempo.

• Import the loop at the session tempo on a 
tick-based, Elastic Audio–enabled track.

• Change the session tempo to change the 
tempo of the region on tick-based, Elastic 
Audio–enabled tracks.

• Quantize the audio to apply a Groove Tem-
plate to the rhythm.

Create and configure a new session:

1  Create a new Pro Tools session.

2  Set the session’s Main Timebase ruler to 
Bars:Beats. 

3  Be sure to display the Tempo and Meter rulers. 
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
4  Use the default tempo of quarter-note equals 
120 BPM.

Locate and preview a loop in DigiBase at the 
session tempo:

1  Open the Workspace (Window > Workspace).

2  Navigate to the folder where you keep your 
drum loops. Double-click the folder name to 
open a volume browser of just the folder’s con-
tents.

3  Select the loop you want to preview.

4  Click the Preview button to preview the loop 
at its native tempo.

5  Click the Audio Files Conform to Session 
Tempo button so that it highlights. 

6  Click the Preview button again and the file 
previews at the session tempo.

Audition Paths for previewing are selected 
in the I/O Setup window (Choose Setup > 
I/O and click the Output tab).

Preview and Audio Files Conform to Session Tempo 
buttons in a DigiBase browser

Audio Files Conform
to Session Tempo buttonPreview button



                  
7  Notice that if the loop was sample-based to be-
gin with, the column to the left of the file name 
initially indicates that DigiBase is analyzing the 
file. When it is done, a check mark appears in 
that column, the file’s Duration is now mea-
sured in Bars and Beats instead of Minutes and 
Seconds, the Sample-based icon is replaced by 
the Tick-based icon, and the detected tempo of 
the file is displayed in the Tempo column.

8  Repeat the preceding steps to preview other 
loops at the session tempo.

Elastic Audio controls and indicators in DigiBase

Sample-based
file iconElastic Audio

Analysis icon Duration
Detected
tempo

Tick-based
file icon
Import the loop at the session tempo:

1  Make sure that the Audio Files Conform to 
Session Tempo button is still highlighted. This 
ensures that the file will be imported as a tick-
based region and can be conformed to the ses-
sion tempo.

2  Drag and drop the loop from the browser to 
the Track List in the session’s Edit window.

3  If there are no tracks in the session and the file 
is tick-based, you are prompted to either import 
the tempo from the file or use the session 
tempo. To keep the session tempo and have the 
loop conform to the session tempo, click Don’t 
Import. 

If there are tracks in the session, the file is im-
ported and conformed to the session tempo.

If All Files is selected as the Drag and Drop 
From Desktop Conforms to Session Tempo 
option in the Processing Preferences page, 
you can also drag and drop audio files from 
the Desktop and they are imported as tick-
based Elastic Audio.

Import Original Tempo from File dialog
Chapter 2: Elastic Audio 7
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4  A new tick-based audio track is created with the Default Elastic Audio plug-in enabled. See Figure 1.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
5  Since you chose to not import the file’s original tempo, you will notice that the loop conforms to 
the tempo map and Bar|Beat grid of the session. A Warp indicator appears in both the region in the 
track and in the Region List. Also in the Region List, notice that there are two regions. One is the sam-
ple-based whole file region (the imported source file) and the other is the tick-based Elastic Au-
dio–processed copy. See Figure 2 below.

Figure 1.  Dragging and dropping a tick-based audio file from a DigiBase browser to the Track List

New tick-based, 
Elastic Audio–enabled

track
You can also conform regions on Elastic Audio–enabled tracks to the session tempo using the Con-
form to Tempo command (see “Conform to Tempo” on page 29).
Figure 2.  Imported tick-based audio file with Elastic Audio processing

Warp indicators

Sample-based whole-file regionTick-based Elastic Audio–processed region



                        
Change the session tempo to change the tempo of 
the region:

1  Change the tempo from the default 120 BPM 
to 110 BPM. (For information about the default 
tempo and tempo changes, see the Pro Tools Ref-
erence Guide.)

2  Notice on-screen that since the region is on a 
tick-based, Real-Time Elastic Audio–enabled 
track it automatically conforms to the new 
tempo.

Changing the default tempo
Quantize audio to apply a Groove Template:

1  Select the region on the tick-based, Real-Time 
Elastic Audio–enabled track.

2  Choose Event > Event Operations > Quantize.

3  In the What to Quantize section, make sure 
Elastic Audio Events is selected in the pop-up 
menu.

4  From the Quantize Grid pop-up menu, select 
the desired Groove Template.

5  Set any other options as desired.

6  Click Apply.

7  In Figure 3, notice that the audio has been 
quantized according to the selected Groove 
Template. In Warp view, you can see that Warp 
markers have been added at every Event marker 
near the Quantize Grid and were used to apply 
quantization to those events. 
Figure 3.  Quantized audio events (Warp markers) in Warp view
Chapter 2: Elastic Audio 9
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Elastic Audio Tracks
Any audio track in your Pro Tools session can be 
Elastic Audio enabled. Elastic Audio tracks can 
be either sample- or tick-based. Sample-based 
Elastic Audio–enabled tracks let you apply real-
time or rendered Elastic Audio processing by ed-
iting in Warp view, applying Quantize, and us-
ing the TCE Trimmer tool. However, only tick-
based Elastic Audio tracks also automatically ap-
ply Elastic Audio processing based on tempo 
changes.

To have all new tracks be tick-based, enable 
the New Tracks Default To Tick Timebase 
option in the Editing Preferences page. 

When creating new tracks by dragging and 
dropping audio from a DigiBase browser, if 
the Audio Files Conform to Session Tempo 
option is enabled, Pro Tools creates tick-
based Elastic Audio–enabled tracks regard-
less of whether the Elastic Audio analyzed 
file is tick-based or sample-based. If the Au-
dio Files Conform to Session Tempo option 
is not enabled, Pro Tools creates regular 
sample-based tracks.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
To enable Elastic Audio on a track:

1  Create a new audio track or choose an existing 
audio track.

2  Click the track’s Elastic Audio Plug-in selector, 
and select the Elastic Audio plug-in appropriate 
to your track material and the results you want 
from the pop-up menu: Polyphonic, Rhythmic, 
Monophonic, Varispeed, or X-Form (see “Elastic 
Audio Plug-ins” on page 15). 

Any audio regions on the track temporarily go 
offline while they are analyzed and come back 
online when the analysis is finished. The wave-
form for audio regions that are offline for Elastic 
Audio analysis appears grayed out.

When recording to a real-time Elastic Audio–en-
abled track, once recording is stopped, the 
newly recorded audio temporarily goes offline 
while it is analyzed and comes back online as 
soon as the analysis is finished.

Elastic Audio Plug-in pop-up menu



3  From the track’s Elastic Audio Plug-in pop-up 
menu, select Real-Time Processing or Rendered 
Processing for Real-Time or Rendered Elastic Au-
dio processing. 

To disable Elastic Audio on a track:

1  From the track’s Elastic Audio Plug-in selector, 
select None – Disable Elastic Audio.

2  If the track had any Elastic Audio-based pro-
cessing, you are prompted to Cancel, Revert, or 
Commit.

Cancel Leaves Elastic Audio enabled on the 
track.

Revert Removes any Elastic Audio processing, 
reverts regions on the track to their original du-
ration, and disables Elastic Audio on the track.

Commit Renders and commits any Elastic Audio 
processing on the track, writes new files to disk, 
and disables Elastic Audio on the track.

Elastic Audio processing can be Real-Time 
or Rendered. Real-Time Elastic Audio pro-
cessing is immediate, but it is more de-
manding of system resources. Rendered 
Elastic Audio processing is non-real-time, 
but is less demanding of system resources. If 
you are working on a system with limited re-
sources, use Rendered Elastic Audio process-
ing. For more information, see “Real-Time 
and Rendered Elastic Audio Processing” on 
page 14.

Commit Elastic Audio dialog
Committed Regions

Regions that are committed, either by disabling 
Elastic Audio on a track or by moving a region to 
a track without Elastic Audio enabled, are writ-
ten to disk as new audio files. These new audio 
files include the audio in the region, plus any 
fades, and also an additional 5 seconds of audio 
before and after the region, if available. 

Alternate Playlists

Disabling Elastic Audio on a track affects all 
playlists on the track. All playlists on the track 
are committed or reverted depending on which 
option you choose.

Creating New Tracks with Elastic Audio 
Enabled

New tracks are created with Elastic Audio auto-
matically enabled in the following cases:

• When the Enable Elastic Audio On New 
Tracks option is enabled in the Processing 
Preferences page (see “Elastic Audio Sec-
tion” on page 45).

• When dragging and dropping tick-based, 
Elastic Audio analyzed files from DigiBase 
browsers to the Track List or empty space in 
the Edit window with the Audio Files Con-
form to Session Tempo option enabled (see 
“Elastic Audio in DigiBase Browsers” on 
page 35).

• When dragging and dropping REX or ACID 
files from the Desktop (if either the REX 
and ACID Files Only option or the All Files 
option is enabled for the Drag and Drop 
from Desktop Conforms to Session Tempo 
preference) or a DigiBase browser (if the 
Audio Files Conform to Session Tempo but-
ton is enabled) to the Track List or empty 
space in the Edit window (see “Importing 
REX and ACID Files” on page 37). 
Chapter 2: Elastic Audio 11
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Elastic Audio Track Controls

Audio tracks provide a new set of controls for 
Elastic Audio. 

Elastic Audio Plug-in Selector Selects the Elastic 
Audio plug-in for Elastic Audio processing (see 
“Elastic Audio Plug-ins” on page 15). You can 
also use the Elastic Audio Plug-in selector to dis-
able Elastic Audio processing, and to select ei-
ther Real-Time or Rendered processing (see 
“Real-Time and Rendered Elastic Audio Process-
ing” on page 14).

Elastic Audio Plug-in Button Displays the name 
of the selected Elastic Audio plug-in. Click the 
Elastic Audio Plug-in button to open the Elastic 
Audio Plug-in window (see “Elastic Audio Plug-
ins” on page 15).

Real-Time or Rendered Processing 
Indicator Lights when Elastic Audio processing is 
real-time and dims when Elastic Audio process-
ing is rendered (see “Real-Time and Rendered 
Elastic Audio Processing” on page 14).

Elastic Audio Track controls

Elastic Audio
Plug-in selector

Elastic Audio
Plug-in button

Real-Time or 
Rendered
Processing
indicator
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Elastic Audio Track Views

Pro Tools 7.4 provides two new track views for 
Elastic Audio–enabled tracks: Warp and Analy-
sis.

Warp View

Warp view lets you manually “warp” (Elastic 
Audio process) audio. In Warp view you can cre-
ate and edit Warp markers. If you are using Elas-
tic Audio to correct the timing of a performance, 
or to achieve special effects, work in Warp view.

Analysis View

Analysis view lets you edit detected Event mark-
ers. In most cases you will not need to use Anal-
ysis view. However, with material that does not 
have clear transients, you may want to work in 
Analysis view to add or relocate Event markers, 
or to delete erroneous Event markers. For exam-
ple, when using Elastic Audio to correct the tim-
ing of a performance, you may need to add, 
move, or remove Event markers in Analysis view 
to achieve the highest quality Elastic Audio pro-
cessing.

Track View pop-up menu

For detailed information on working in 
Warp view, see “Editing in Warp View” on 
page 19.

For detailed information on working in 
Analysis view, see “Editing in Analysis 
View” on page 26.



Elastic Audio Analysis
When recording, pasting, moving, or importing 
un-analyzed audio to an Elastic Audio–enabled 
track, or when enabling Elastic Audio on an ex-
isting audio track, Pro Tools automatically ana-
lyzes the audio for transient events. In Wave-
form view, the waveform initially appears 
grayed out because regions go offline during 
Elastic Audio analysis. Once the analysis is com-
plete, the audio comes back online. Elastic Au-
dio analysis is file-based, which means that even 
if you are only working with a small region of a 
large file, the entire audio file is analyzed.

Elastic Audio analysis detects transient events in 
the audio file. These transient events are indi-
cated by Event markers. Event markers are dis-
played in both the Warp and Analysis track 
views. Elastic Audio analysis also calculates the 
native tempo of the analyzed audio file and its 
duration in bars and beats.

Elastic Audio analysis data (detected events, 
tempo, and duration in Bars:Beats) is stored 
with the file. In DigiBase browsers, analyzed au-
dio files are indicated by a check mark to the left 
of the file name, and these files display their du-
ration in Bars|Beats, their timebase as ticks, and 
their native tempo in BPM.

Tempo Detection

Elastic Audio analysis does its best to detect a 
regular tempo for all analyzed audio. Any audio 
containing regular periodic rhythm can be suc-
cessfully analyzed for tempo and duration in 
bars and beats. Analyzed files in which a tempo 
was detected are treated as tick-based files. Tick-
based files can be conformed to the session 
tempo for preview and import.
Analyzed files in which no tempo was detected 
are treated as sample-based files. If there is only 
a single transient in the file (such as with a sin-
gle snare hit), no tempo will be detected. Also, 
longer files that contain tempo changes or ru-
bato, or that do not contain regular periodic 
rhythmic patterns will probably not have a de-
tected tempo and will be treated as sample-
based files.

Event Confidence

Transient events are detected with a certain de-
gree of confidence. The level of confidence is 
based on the relative clarity of transients.

For example, a drum loop is likely to have clear, 
sharp transients. These will be detected with a 
high degree of confidence. However, a legato vi-
olin melody may not have clear, sharp tran-
sients, so transients will be detected with a lower 
degree of confidence. 

Pro Tools is very aggressive with its transient de-
tection in order to detect every possible audio 
event. Consequently, it is possible to have erro-
neously detected events. These events will be 
analyzed with a low degree of confidence and 
can be filtered out by lowering the Event Sensi-

Note that peak amplitude is not the most 
important measure for event confidence. 
The clarity of transients is measured in part 
by the spectral transition from one moment 
to the next. This tends to favor higher fre-
quency content in terms of event confidence. 
For example, changing the Event Sensitivity 
in the Elastic Properties window for a se-
lected drum loop results in the clearer tran-
sients of the higher frequency hi-hat hits 
having more event confidence than the less 
well defined transients of the lower fre-
quency kick drum hits even though kick 
drum hits have a higher peak amplitude.
Chapter 2: Elastic Audio 13
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tivity in the Elastic Properties window (see 
“Event Sensitivity” on page 33). Filtering out 
any false transients can result in higher quality 
Elastic Audio processing. 

Conversely, for material with few clear tran-
sients, Elastic Audio analysis may not accurately 
detect audio events, and those detected may be 
detected with a low level of confidence. You can 
relocate or add Event markers where necessary 
in Analysis view (see “Editing in Analysis View” 
on page 26). 

For example, a slow synth pad may not have 
clear transients and detected Event markers may 
be incorrectly located or may have not been de-
tected at all. In Analysis view, you can relocate, 
remove, and add Event markers as necessary 
(such as where the chord changes). Accurately 
locating Event markers yields better results 
when applying Elastic Audio processing.

When processing non-rhythmic audio (such 
as legato strings) with the Polyphonic plug-
in, reducing the number of Event markers 
often yields better sounding results. You can 
either manually remove Event markers in 
Analysis view (see “Editing in Analysis 
View” on page 26) or lower the Event Sensi-
tivity setting in the Elastic Properties win-
dow for the region you want to process (see 
“Elastic Properties Window” on page 31).
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Real-Time and Rendered 
Elastic Audio Processing
Real-Time Elastic Audio processing means that 
any changes to Elastic Audio processing—
whether it be a tempo change or a manual TCE 
warp—take effect immediately. However, Real-
Time Elastic Audio processing can be very de-
manding on your system’s resources. Conse-
quently, you may want to use Rendered Elastic 
Audio processing in some cases. With Rendered 
Elastic Audio processing, when you make a 
change to Elastic Audio processing, any affected 
audio regions temporarily go offline, a new 
“rendered” audio file is generated, and any af-
fected audio regions come back online.

To set an Elastic Audio track to Real-Time or 
Rendered:

1  Click the track’s Elastic Audio Plug-in selector.

2  From the pop-up menu, select the desired 
Elastic Audio plug-in.

3  From the pop-up menu, select one of the fol-
lowing:

• Real-Time Processing

• Rendered Processing

In rendered mode, any change you make is 
rendered using the original source audio to 
avoid generational loss from multiple subse-
quent edits.

Select Real-Time processing for tick-based 
Elastic Audio processing (such as tempo 
changes). Rendered audio processing can be 
useful for sample-based Elastic Audio pro-
cessing or if you need to save system re-
sources.



About Rendered Files

Pro Tools creates temporary files for Rendered 
Elastic Audio processing. These files are kept in a 
new, auto-created Rendered Files folder in the 
session folder. Once you commit Rendered Elas-
tic Audio processing to a track (by disabling 
Elastic Audio on a track and clicking Commit in 
the Commit Elastic Audio dialog), a new file is 
written to disk in the Audio Files folder, and the 
temporary rendered file from which it was cre-
ated is deleted from the Rendered Files folder.

Region Clip Indicator

(Rendered Processing Only)

Since Rendered Elastic Audio processing is not 
real-time, it does not report clipping due to Elas-
tic Audio processing in the Elastic Audio plug-in 
window. Instead, when clipping occurs due to 
Rendered Elastic Audio processing, the region 
displays an Elastic Audio Processing Clip indica-

Elastic Audio Plug-in selector and pop-up menu

To toggle between Real-Time and Rendered 
Elastic Audio processing, Control-Start-
click (Windows) or Command-Control-
click (Mac) the Elastic Audio Plug-in but-
ton.
tor just to the left of the Warp indicator. To 
avoid clipping on playback, lower the Input 
Gain for the region in the Elastic Properties win-
dow (see “Elastic Properties Window” on 
page 31).

Elastic Audio Plug-ins
Pro Tools 7.4 provides several TCE algorithms 
for real-time and rendered track-based Elastic 
Audio processing. The selected Elastic Audio 
plug-in determines how the audio is processed. 
Each plug-in uses different algorithms for Elastic 
Audio processing. Different algorithms are bet-
ter suited to different types of audio. Select the 
plug-in whose algorithm is appropriate to the 
material on the track you want to process.

Elastic Audio plug-ins have their own unique se-
lector that is only available in the Edit window. 
You cannot insert Elastic Audio plug-ins on 
track Plug-in Inserts (TDM, RTAS, and hardware 
inserts).

Elastic Audio plug-ins provide few to no adjust-
able parameters. The adjustable controls, if any, 
for Elastic Audio plug-ins are available in the 
Elastic Audio Plug-in window. Elastic Audio 
plug-in parameters cannot be automated.

Elastic Audio Region Clip indicator

Elastic Audio Region
Clip indicators

Warp 
indicators
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To open an Elastic Audio Plug-in window:

� Click the Elastic Audio Plug-in button.

Elastic Audio Plug-in Window Controls

The Elastic Audio Plug-in window provides a set 
of controls in the window header that are com-
mon to all Elastic Audio plug-ins.

Track Selector Accesses any other audio track in 
the session.

Plug-in Selector Lets you select any Elastic Audio 
plug-in or disable Elastic Audio.

Real-Time or Rendered Processing 
Indicator Lights when Elastic Audio processing is 
real-time and dims when Elastic Audio process-
ing is rendered (see “Real-Time and Rendered 
Elastic Audio Processing” on page 14).

Elastic Audio plug-in button

Elastic Audio plug-in controls

Elastic Audio
Plug-in button

Settings menu

Track selector

Librarian menu
Target 
button

Clip 
LED

Plug-in selector

Real-Time or 
Rendered
Processing
indicator

Next and Previous Settings buttons

Compare button
Plug-ins Settings Select button
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Clip LED Lights red to indicate clipping in the 
Elastic Audio processing. Clipping can occur 
when time compressing audio. If clipping oc-
curs, you can lower the Input Gain in the Elastic 
Properties window (“Input Gain” on page 33), 
or attenuate the Default Input Gain in the Pro-
cessing Preferences page (see “Elastic Audio Sec-
tion” on page 45). 

You can also undo any Elastic Audio processing 
and apply an appropriate amount of AudioSuite 
Gain reduction, and then try the Elastic Audio 
processing again. The Clip LED only functions 
for Real-Time Elastic Audio processing; it does 
not function for rendered Elastic Audio process-
ing. 

Settings Menu Lets you copy, paste, save, and 
import plug-in settings.

Librarian Menu Recalls settings files saved in the 
plug-in’s root settings folder or in the current 
session’s Settings folder.

Next (+) and Previous (–) Setting Buttons Let 
you select the next or previous plug-in setting 
from the Librarian menu.

Plug-ins Settings Select Button Accesses the 
Plug-in Settings dialog, which lists the settings 
files for the current plug-in. From this list, you 
can select a new setting, or audition a series of 
settings.

For Rendered Elastic Audio processing, clip-
ping is indicated by the appearance of the 
Elastic Audio Processing Clip indicator on 
the region (see “Region Clip Indicator” on 
page 15).

You will lose the current settings if they are 
not saved before you use the Next and Pre-
vious Setting buttons. Always save your set-
tings to the Librarian menu.



Compare Toggles between the original saved 
plug-in setting and any changes you have made 
to it so you can compare them.

Target Button When multiple Elastic Audio 
Plug-in windows are open, clicking this button 
selects that plug-in as the target for any com-
puter keyboard commands. Deselecting the Tar-
get button lets you open another targeted Elastic 
Audio Plug-in window.

Polyphonic

The Polyphonic plug-in is a general, all-purpose 
algorithm that is effective with a wide range of 
material. For complex loops and multi-instru-
ment mixes, use the Polyphonic plug-in. 

Follow

Selecting the Follow option enables an envelope 
follower that simulates the original acoustics of 
the audio being stretched. Click the Follow but-
ton to enable or disable envelope following.

The Polyphonic plug-in is the default plug-
in for previewing and importing from Digi-
Base browsers or the Region List.

Elastic Audio plug-in: Polyphonic
Window

The Polyphonic plug-in provides a single con-
trol for adjusting the analysis window size for 
TCE processing. Experiment with adjusting the 
Window size for different types of material until 
you achieve the best results. The following table 
provides some recommended Window sizes for 
different types of material.

Rhythmic

The Rhythmic plug-in is best suited to material 
with clear attack transients, such as drums. 

Decay Rate

The Decay Rate control determines how much 
of the decay from a transient is heard in the pro-
cessed audio when time stretching. When the 
Rhythmic plug-in is selected, any gaps between 

Type of Material
Recommended 
Window Size

General purpose 30–40 ms

Percussive 20 ms or lower

Pads and other legato 
material

60 ms or higher

If you frequently work with distinct types of 
material, you may want to find the best 
Window settings for each type of material 
and save them as plug-in settings for quick 
and easy recall.

Elastic Audio plug-in: Rhythmic
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18
transients resulting from time stretching are 
filled in with audio. The Decay Rate determines 
how much of this audio is heard by applying a 
fade out rate. Adjust the Decay Rate up to 100% 
to hear the audio that is filling the gaps created 
by the time stretching with only a slight fade, or 
adjust down to 1.0% to completely fade out be-
tween the original transients.

Monophonic

The Monophonic plug-in is best suited to 
monophonic material where you want to keep 
the formant relationships intact, such as with 
vocals. The Monophonic plug-in is also well 
suited to monophonic instrumental lines, such 
as a bass track. The Monophonic plug-in pro-
vides no plug-in specific parameters.

Elastic Audio plug-in: Monophonic

The Monophonic plug-in analyzes pitch as 
well as peak transients in order to provide 
higher quality TCE to pitched material. 
Consequently, analysis for the Monophonic 
algorithm takes longer than for the Poly-
phonic, Rhythmic, and Varispeed algo-
rithms. Also, when switching from another 
Elastic Audio plug-in to Monophonic, 
Pro Tools reanalyzes any audio on the track 
to collect the extra analysis data.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Varispeed

Use the Varispeed plug-in to link time and pitch 
changes for tape-like speed change effects, and 
post production workflows. The Varispeed plug-
in provides no plug-in specific controls.

X-Form
(Rendered Only)

The X-Form plug-in provides the highest quality 
time compression and expansion algorithms for 
music production, sound design, and audio 
loop applications. However, the X-Form Elastic 
Audio plug-in is for Rendered Elastic Audio pro-
cessing only and cannot process in real-time.

Elastic Audio plug-in: Varispeed

Try using Varispeed with Quantize on drum 
loops for some interesting effects.

Elastic Audio plug-in: X-Form



Quality

Select either Maximum or Low (Faster) from the 
Quality pop-up menu. Maximum is the slowest 
processing algorithm, but provides the highest 
quality results. Low (Faster) produces relatively 
good results and is much faster than the Maxi-
mum setting.

Formant

For audio material with clear formants, enable 
Formant to preserve the formant shape of audio 
when applying TCE processing.

Audio with a fundamental pitch has an 
overtone series, or set of higher harmonics. 
The strength of these higher harmonics cre-
ates a formant shape, which is apparent if 
viewed using a spectrum analyzer. The over-
tone series, or harmonics, have the same 
spacing related to the pitch and have the 
same general shape regardless of what the 
fundamental pitch is. It is this formant 
shape that gives the audio its overall char-
acteristic sound or timbre. When pitch 
shifting audio, the formant shape is shifted 
with the rest of the material, which can re-
sult in an unnatural sound. Keeping this 
shape constant is critical to formant correct 
pitch shifting and achieving a natural 
sounding result.
Editing in Warp View
In the new Warp Track View in Pro Tools 7.4, 
you can manually “warp” (TCE) audio to correct 
or adjust the timing of a performance, or create 
special effects. In Warp view, you can add, 
move, and delete Warp markers. Warp markers 
are used to fix a specific point in the audio (typ-
ically a detected transient event) to a specific 
point in the Timeline. In this way, you can ap-
ply detailed and nuanced “warping” (TCE) of 
audio events.

To display Warp view:

1  Click the Elastic Audio–enabled track’s Track 
View selector.

2  Select Warp from the Track View pop-up 
menu.

Selecting Warp view for an Elastic Audio–enabled track

Warp view is only available for Elastic Au-
dio–enabled tracks.
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Elastic Audio Markers in Warp 
View

Three types of markers are visible in Warp view: 
Event markers, Warp markers, and Tempo 
Event–generated Warp markers. Use Event 
markers and Warp markers as control points for 
applying Elastic Audio processing. 

Event Markers

Event markers indicate detected (or manually 
created) audio events. Event markers are only 
displayed in Warp view and Analysis view. In 
Warp view, Event markers appear as gray verti-
cal lines that do not fully extend to the top and 
bottom of the track. With the Grabber tool in 
Warp view, you can drag Event markers to apply 
various kinds of warping depending on whether 
or not Warp markers are present in the region as 
well. In Warp view, you cannot add, relocate, or 
delete Event markers. Use Analysis view to edit 
Event markers (see “Editing in Analysis View” 
on page 26).

Figure 4.  Elastic Audio markers in Warp view

The display of Event markers is dependent 
on Horizontal Zoom. If you are zoomed out 
too far, Event markers are not displayed. To 
see Event markers, zoom in.

Warp marker
Event marker

Tempo Event
Warp marker
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Warp Markers

Warp markers anchor the audio to a specific 
point in the Timeline. Warp markers are only 
displayed in Warp view. In Warp view, a Warp 
marker appears as a thick black vertical line with 
a triangle at its base.

To better understand how Warp markers work, 
think of the audio region as a rubber band, the 
Timeline as a ruler, and Warp markers as pins. 
Warp markers can be used to pin a specific point 
of the rubber band (the audio) to a specific point 
on the ruler (the Timeline). If you pin down one 
point of the rubber band to one point on the 
ruler, use a second pin to pin down another 
point of the rubber band to another point on 
the ruler, and then place a third pin equally be-
tween them on the rubber band, but fix it to a 
point on the ruler closer to the second pin, the 
rubber band will be stretched (or expanded) be-
tween the first and middle pins, and relaxed (or 
compressed) between the middle pin and the 
last pin. 

In Warp view, you can add, relocate (without 
warping), and delete Warp markers. You can 
also move a Warp marker to apply Elastic Audio 
processing (see “Warping Audio” on page 22).



To add a Warp marker:

� In Warp view, do one of the following:

• With the Pencil tool, click anywhere in the 
region to add a Warp marker at that loca-
tion. If you click on an Event marker, a 
Warp marker is created on top of the Event 
marker.

• With the Grabber tool, Start-click (Win-
dows) or Control-click (Mac) anywhere in 
the region to add a Warp marker at that lo-
cation. If you click on an Event marker, a 
Warp marker is created on top of the Event 
marker.

• With the Grabber tool, if no Warp markers 
are present in the region, or if Warp mark-
ers are only present prior to the location 
where you want to add a new Warp marker, 
double-click an Event marker to add a 
Warp marker on top of the Event marker.

• With the Grabber tool, double-click any-
where in the region where an Event marker 
is not present to add a Warp marker at that 
location.

• With the Grabber tool, single-click any 
Event marker prior to another existing 
Warp marker in the region to add a Warp 
marker on top of that Event marker.

• With any Edit tool, Right-click anywhere in 
the region and select Add Warp Marker 
from the pop-up menu to add a Warp 
marker at that location. If there is an Edit 
selection, Warp markers are added at the se-
lection start and end.

To relocate a Warp marker (without applying 
warping):

� With the Grabber or the Pencil tool, Start-
click (Windows) or Control-click (Mac) and drag 
a Warp marker to a new location.
To delete a Warp marker:

� In Warp view, do one of the following:

• With the Grabber tool, double-click a Warp 
marker.

• With the Grabber or the Pencil tool, Alt-
click (Windows) or Option-click (Mac) a 
Warp marker.

• With any Edit tool, Right-click a Warp 
marker and select Remove Warp Marker 
from the pop-up menu.

To delete all Warp markers in a selection:

1  In Warp view, make an Edit selection that in-
cludes only the Warp markers you want to de-
lete (and none of the Warp markers you want to 
keep).

2  Do one of the following:

• Press Delete or Backspace on your com-
puter keyboard.

– or –

• With any Edit tool, Right-click the Edit se-
lection and select Remove Warp Marker 
from the pop-up menu.

Tempo Event–Generated Warp Markers

Tempo Event–generated Warp markers are not 
editable and are only displayed to indicate 
where Elastic Audio processing has been applied 
to conform the audio to Tempo Events (see 
“Tempo Changes and Tick-Based Elastic Audio 
Tracks” on page 28). You will only see Tempo 
Event–generated Warp markers on tick-based 
tracks. In Warp view, Tempo Event–generated 
Warp markers appear as gray vertical lines that 
do not fully extend to the bottom of the track, 
and have a diamond at the top.

If you change the track timebase from ticks to 
samples, any Tempo Event–generated Warp 
markers convert to regular, editable Warp mark-
ers.
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Warping Audio

In Warp view, you can manually warp audio in 
three specific ways: Telescoping Warp, Accor-
dion Warp, and Range Warp. 

Telescoping Warp

Telescoping Warp can be applied to any audio 
region before or after a Warp marker as long as 
no other Warp marker precedes or follows it ac-
cordingly. The audio can be on a sample- or tick-
based track. Telescoping Warp is especially use-
ful for adjusting audio files to match the session 
tempo map and Bar|Beat grid. 

Automation does not follow manual warp-
ing of audio regions, including TCE trim-
ming and quantization of Elastic Audio. 
However, automation does follow tempo 
changes on tick-based tracks.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
To apply Telescoping Warp to a region:

� In Warp view, do one of the following:

• With the Grabber tool, drag any Event 
marker that is after the last Warp marker in 
the region to the left or right to Telescope-
Warp the audio that is after the Warp 
marker in or out. If no Warp marker is 
present in the region, one is created auto-
matically at the region start. The region 
start remains anchored to its location on 
the Timeline.

– or –

• With the Grabber tool, Alt-click (Windows) 
or Option-click (Mac) and drag any Event 
marker that is before the first Warp marker 
in the region to the left or right to Tele-
scope-Warp the audio that is before the 
Warp marker in or out. If no Warp marker is 
present in the region, one is created auto-
matically at the region end. The region end 
remains anchored to its location on the 
Timeline.

Telescoping Warp with the region start fixed

Before warping

After warping



Workflow Example

Beat match a song to the session tempo and 
Bar|Beat grid using Telescoping Warp:

1  Make sure the Main Timebase ruler is set to 
Bars:Beats.

2  Set the default tempo and meter as desired.

3  Select Grid mode.

4  Import a song, or any other longer audio file 
from a DigiBase browser.

5  Make sure that Elastic Audio is enabled on the 
track. 

6  Select Warp view.

7  Make sure there are no Warp markers present 
on the region. If necessary, delete any exisiting 
Warp markers.

8  With the Pencil tool, add a Warp marker at the 
bar 1 downbeat location within the region.

9  With the Grabber tool, drag the single Warp 
marker to the bar in the Timeline where you 
want the downbeat of the audio file to start.

10  Click and drag the Event marker on the 
downbeat of bar 2 of the region to Telescope 
warp the audio such that the Event marker 
matches the corresponding bar number in the 
Bars:Beats ruler.

11  If the region’s tempo varies, add a Warp 
marker to the next downbeat location at the 
tempo change and repeat the preceding steps.
Accordion Warp

Accordion Warp applies Elastic Audio process-
ing on both sides of a singe Warp marker in a re-
gion. This lets you expand or compress the au-
dio equally on both sides of a fixed point. 
Accordion warp is useful for audio files where 
the downbeat occurs in the middle of the re-
gion.

To apply Accordion Warp to a region:

1  In Warp view, add a single Warp marker at the 
point in the region that you want to remain 
fixed on the Timeline.

2  With the Grabber tool, drag any Event marker 
that is before or after the single Warp marker to 
the left or the right.

Accordion Warping a region around a fixed point

Before warping

After warping
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Range Warp

Range Warp applies Elastic Audio processing be-
tween two fixed points in a region. To apply 
Range Warp, there must be at least two Warp 
markers present in the region.

To apply Range Warp within a region:

1  In Warp view, add a Warp marker at the first 
point that you want to fix to the Timeline.

2  Add another Warp marker to the end point 
that you want to fix to the Timeline.

3  With the Grabber tool, drag an Event marker 
between the two Warp markers to the left or 
right. A Warp marker is added on top of the 
Event marker and the audio is compressed or ex-
panded on either side of the clicked and dragged 
marker while the audio outside the bounding 
markers remains unaffected.

Applying Range Warp between two Warp markers in a 
region

Before warping

After warping
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Range Warp with an Edit Selection

Pro Tools lets you apply Range Warp between 
bounding Warp markers, but keeps the timing 
intact between other Warp markers within an 
Edit selection.

To apply Range Warp with an Edit Selection:

1  In Warp view, add a Warp marker at the first 
point that you want to fix to the Timeline.

2  Add another Warp marker to the end point 
that you want to fix to the Timeline.

3  Add any number of Warp markers in between.

4  With the Selector tool, make an Edit selection 
that includes the Warp markers in between the 
bounding Warp markers.

5  With the Grabber tool, drag any of the Warp 
markers within the Edit Selection to the left or 
the right. 

Applying Range Warp to a selection between bounding 
Warp markers

Before warping

After warping



Elastic Audio processing is only applied to the 
audio between the bounding Warp markers and 
the first and last Warp markers in the Edit Selec-
tion. All audio between the first and last Warp 
markers in the Edit Selection maintain their rel-
ative timing.

Individual Range Warp

Individual Range Warp applies warping to a sin-
gle audio event in relation to the adjacent audio 
events.

To apply Individual Range Warp:

1  In Warp view, with the Grabber tool, Shift-
click a Warp marker or an Event marker. If not 
already present, Warp markers are automatically 
created on the adjacent Event markers.

2  Drag to the left or right to warp the clicked 
event.

Applying Individual Range Warp 

Before warping

After warping
Warped Regions

Regions that have been warped either manually 
or automatically by tempo change or quantiza-
tion, display a Warp indicator in the upper 
right-hand corner of the region. This icon is vis-
ible in any track view. Since unwarped regions 
can reside on Elastic Audio–enabled tracks, re-
gions on Elastic Audio–enabled tracks do not 
necessarily display the Warp indicator. The 
Warp indicator only indicates that Elastic Audio 
processing has been applied to a region.

Displaying the Warp Indicator

The Warp indicator for Elastic Audio regions can 
displayed or hidden.

To toggle the display of the Warp indicator in 
Elastic Audio regions:

� Select or deselect View > Region > Warp Indi-
cator. 

Out of Range Processing

Pro Tools lets you apply extreme amounts of 
Elastic Audio processing. However, at such ex-
tremes, it is possible to go out of the processing 
range of the selected Elastic Audio plug-in. 
When this happens, it is possible that not every 
sample will be processed correctly and you may 
encounter audio drop outs. 

Warp indicator in a region in Waveform view

Warp
indicator
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The valid range for Elastic Audio TCE processing 
is 1/4x to 4x for all Elastic Audio plug-ins except 
X-Form, which supports 1/8x to 8x. TCE less 
than or greater than these ranges is effectively 
“out of range.”

When out of range processing occurs, the sec-
tion of the audio region that is out of range 
turns red. You can still apply the out of range 
Elastic Audio processing, but you are warned by 
the color change that the TCE factor is out of the 
normal range of Elastic Audio processing.

Removing Region Warping

If you have applied any warping to a region, you 
can remove warping and revert the region to its 
original duration. This can be useful if you are 
not satisfied with the results and want to revert 
to the pre-warped region. Warp markers are not 
deleted when applying the Remove Warp com-
mand, but any warping is undone.

Red indicates that the TCE Factor is out of range

The TCE Factor in the Elastic Properties 
window supports extreme ranges from 
1–9999%. However anything outside of 
25–400% will be “out-of-range” and will 
be displayed in red.

TCE Factor
out of range
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
To remove region warping:

1  Select the region for which you want to re-
move warping.

2  Do one of the following:

• Choose Region > Remove Warp.

– or –

• With any Edit tool, Right-click the region 
and select Remove Warp from the pop-up 
menu.

Edit Groups and Warp Editing

Elastic Audio–enabled tracks can be included in 
Edit Groups. For Elastic Audio–enabled tracks 
that are part of an Edit Group, applying Elastic 
Audio processing on one track likewise applies it 
to all other tracks within that Edit Group. 

Editing in Analysis View
In Analysis view, you can add, move, and delete 
Event markers. Usually, Pro Tools accurately de-
tects all the transient events in an audio file and 
you will not need to work in Analysis view. 
However, Pro Tools may not accurately detect 
every audio event or may erroneously detect au-
dio events with some types of audio material. 
This is especially true for audio without clear 
transients, such as legato strings, melismatic vo-
cals, or a soft synth pad. 

Remove Warp can only be applied to re-
gions and cannot be applied to region 
groups. To unwarp region groups you must 
first ungroup the region, then apply Remove 
Warp to the underlying regions, and then 
regroup those regions.



Use Analysis view to manually correct the pres-
ence and location of Event markers. The accu-
rate identification of audio events (Event mark-
ers) yields the best results when applying Elastic 
Audio processing.

To display Analysis view:

1  Click the Elastic Audio–enabled track’s Track 
View selector.

2  Select Analysis from the Track View Selector 
pop-up menu.

Selecting Analysis view for an Elastic Audio–enabled 
track

Analysis view is only available for Elastic 
Audio–enabled tracks.

In Analysis view, you can only edit Analysis 
markers using the Edit tools. You cannot 
use the Edit tools for any region editing. 
Switch to Warp or Waveform views for re-
gion-based editing capabilities with the 
Edit tools.
Adding Event Markers

To add an Event marker:

� In Analysis view, do one of the following:

• With the Pencil tool, click at the location 
where you want to add an Event marker.

• With the Grabber tool, double-click at the 
location where you want to add an Event 
marker.

• With the Grabber tool, Start-click (Win-
dows) or Control-click (Mac) at the loca-
tion where you want to add an Event 
marker.

• With any Edit tool, Right-click at the loca-
tion where you want to add an Event 
marker and select Add Event Marker from 
the pop-up menu.

Moving Event Markers

To move an Event marker:

� In Analysis view, do one of the following:

• With the Pencil tool, drag the Event marker 
to a new location.

– or –

• With the Grabber tool, drag the Event 
marker to a new location.

Adding an Event marker with the Pencil tool

Moving an Event marker
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Deleting Event Markers

To delete an Event marker:

� In Analysis view, do one of the following:

• With the Pencil tool, Alt-click (Windows) 
or Option-click (Mac) the Event marker 
you want to delete.

• With the Grabber tool, Alt-click (Windows) 
or Option-click (Mac) the Event marker 
you want to delete.

• With the Selector tool, make an Edit selec-
tion that includes any Event markers you 
want to delete and press Delete or Back-
space on your computer keyboard.

• With the Selector tool, make an Edit selec-
tion that includes any Event markers you 
want to delete, Right-click the selection, 
and choose Remove Event Marker from the 
pop-up menu.

Edit Groups and Event Editing

Elastic Audio–enabled tracks can be included in 
Edit Groups. For Elastic Audio–enabled tracks 
that are part of an Edit Group, editing Event 
markers on one track likewise apply to all other 
tracks within that Edit Group.

If corresponding Warp markers are not already 
present on Elastic Audio–enabled tracks that are 
part of an Edit Group, new Warp markers are 
created on those tracks when you add or move a 
Warp marker on any track that is part of the Edit 
Group.

Deleting an Event marker with the Pencil tool
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Tempo Changes and Tick-
Based Elastic Audio Tracks
Regions on tick-based, Elastic Audio–enabled 
tracks apply Time Compression and Expansion 
(TCE) based on tempo changes. For simple 
tempo changes, regions on tick-based Elastic 
Audio–enabled tracks automatically conform to 
match the new tempo. Tempo changes do not 
affect sample-based, Elastic Audio–enabled 
tracks. In Figure 5 below, the first two-bar region 
is at its native tempo of 120 bpm. The second 
two-bar region has been conformed to the 
tempo change of 100 bpm. Since the second re-
gion has been warped to remain two-bars long 
at the slower tempo, it displays the Region Warp 
indicator in the upper right-hand corner of the 
region.

For tempo curves, such as an accelerando or ri-
tardando, Tempo Event Warp markers are auto-
matically created corresponding to each tempo 
event, and the region conforms accordingly. 
Figure 6 below shows a region in Warp view. 
Notice how the audio conforms to the tempo 
curve.

Figure 5.  Tempo conformed audio, linear tempo change

Figure 6.  Tempo conformed audio, tempo curve



Tempo Event–generated Warp markers cannot 
be edited. They only show where the audio has 
been warped in order to conform to tempo 
changes.

Conform to Tempo

Pro Tools lets you conform regions on Elastic 
Audio–enabled tracks (both sample- and tick-
based) to the session tempo. If necessary, the 
Conform to Tempo command analyzes selected 
region to determine its tempo and duration (in 
bars and beats), and then applies Elastic Audio 
processing to conform the region to match the 
session tempo.

To conform a region to the session tempo:

1  Select the region you want to conform to the 
session tempo. The region must be on an Elastic 
Audio–enabled track, but the track timebase can 
be either ticks or samples.

2  Do one of the following:

• Choose Region > Conform to Tempo.

– or –

• Right-click the region you wan to conform 
to tempo and select Conform to Tempo 
from the pop-up menu.

Pro Tools analyzes the region’s entire file for 
Elastic Audio events and tempo. If a tempo is de-
tected, and a duration in bars and beats is deter-
mined, the region conforms automatically to 
the session tempo. If a tempo and duration is 

If you change the track timebase from ticks 
to samples, any Tempo Event–generated 
Warp markers convert to regular, editable 
Warp markers.
not detected (such as with a region that is a sin-
gle drum hit or with a long region with no clear 
tempo), the region is not conformed to the ses-
sion tempo. 

Alternate Playlists

Alternate playlists on Elastic Audio–enabled, 
tick-based tracks are only affected by tempo 
changes. Otherwise, alternate playlists are not 
affected by editing Warp or Event markers in the 
main playlist.

You can also use telescoping warp in Warp 
view to manually conform a long region to 
the session tempo. See “Telescoping Warp” 
on page 22.

Conform to Tempo can only be applied to 
regions and cannot be applied to region 
groups. To conform region groups to the 
tempo you must first ungroup the region 
group, then apply Conform to Tempo to the 
underlying regions, and then regroup those 
regions.
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Moving Elastic Audio Between Tracks
Pro Tools analyzes, conforms, and commits audio in different ways when moving audio regions be-
tween tracks with Elastic Audio enabled and tracks without Elastic Audio enabled. The following table 
shows the different results for moving regions between real-time Elastic Audio–enabled tracks, Ren-
dered Elastic Audio–enabled tracks, and audio tracks without Elastic Audio.
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From To Result

Real-time Elastic 
Audio–enabled track

Rendered Elastic 
Audio–enabled track

Render region with destination track’s Elastic Audio 
plug-in

Real-time Elastic 
Audio–enabled track

audio track (no Elastic 
Audio)

Render region with source track’s Elastic Audio plug-in 
and commit the region to the destination track

Rendered Elastic 
Audio–enabled track

Real-time Elastic 
Audio–enabled track

Apply real-time Elastic Audio processing using the des-
tination track’s Elastic Audio plug-in

Rendered Elastic 
Audio–enabled track

audio track (no Elastic 
Audio)

Commit to track

Audio track (no Elastic 
Audio)

Real-time Elastic 
Audio–enabled track

Calculate Elastic Audio analysis and apply real-time 
Elastic Audio processing using the destination track’s 
Elastic Audio plug-in

Audio track (no Elastic 
Audio)

Rendered Elastic 
Audio–enabled track

Calculate Elastic Audio analysis and render the region 
using the destination track’s Elastic Audio plug-in

Regions that are committed, either by disabling Elastic Audio on a track or by moving a region to a 
track without Elastic Audio enabled, are written to disk as new audio files (see “Committed Regions” 
on page 11.)



Elastic Properties
Each region on an Elastic Audio–enabled track 
has specific Elastic Audio properties (such as 
tempo, meter, TCE factor, and Input Gain). 

The Elastic Properties window lets you view and 
change the properties for selected regions. For 
example, you can reduce the Input Gain for 
Elastic Audio processing to avoid clipping that 
can occur during processing.

From the Elastic Properties window, you can 
also filter Event markers for Elastic Audio re-
gions on tick-based tracks. Filtering Event mark-
ers can result in better quality Elastic Audio pro-
cessing of material with ambiguous transients.

To view the Elastic Properties for a region:

1  Select a region on an Elastic Audio–enabled 
track. The track can be either sample- or tick-
based.

2  Do one of the following:

• Choose Region > Elastic Properties. 

– or –

• Right-click the region and choose Elastic 
Properties from the pop-up menu.
Elastic Properties Window

The Elastic Properties window displays informa-
tion about Elastic Audio processing and analysis 
for one or more regions. You can also use the 
Elastic Properties window to adjust Elastic Audio 
processing and analysis data.

There are different Elastic Properties available in 
the Elastic Properties window, depending on 
whether the track is tick-based or sample-based. 
If the track is sample-based, a reduced set of 
Elastic Audio Properties are displayed.

Region

The Region property displays the name of the 
region and indicates whether or not the region 
is on a tick or sample-based track. If more than 
one region is selected, the number of selected re-
gions is displayed. If regions on both tick and 
sample-based tracks are selected, only the re-
duced set of properties are displayed.

Elastic Properties window (tick-based Elastic 
Properties)

Elastic Properties window (sample-based Elastic 
Properties)
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Source Length (Tick-Based Tracks Only)

The Source Length property displays the length 
of the region based on the source file in bars and 
beats. If the length of the source file was ana-
lyzed incorrectly, you can change it. 

To change the Source Length of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Do one of the following:

• Type the correct bar, beat, and tick values 
in the Source Length field.

• If the duration was incorrectly analyzed as 
being half the duration of the source file, 
click the x2 button.

• If the duration was incorrectly analyzed as 
being twice the duration of the source file, 
click the 1/2 button.

Source Tempo (Tick-Based Tracks Only)

The Source Tempo property displays the average 
tempo of the source file, which is calculated 
based on the detected transient events and the 
length of the file. If the tempo of the source file 
was analyzed incorrectly, you can change it.

Changing the duration of a region on an 
Elastic Audio–enabled track using the TCE 
Trimmer tool updates the Source Length in 
the Elastic Properties window.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
To change Source Tempo of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Select the correct note value for the beat from 
the Tempo Resolution pop-up menu. For exam-
ple, if the source file is in 5/8, select 1/8 note.

3  Do one of the following:

• Type the tempo in the Source Tempo field.

• If the tempo was incorrectly analyzed as 
being half the tempo of the source file, 
click the x2 button.

• If the tempo was incorrectly analyzed as 
being twice the tempo of the source file, 
click the 1/2 button.

Meter (Tick-Based Only)

Elastic Audio analysis does not calculate meter 
and assumes all files are in 4/4. If you work with 
meters other than 4/4, use the Meter property to 
correctly identify the source meter.

To change Meter of a region:

1  Open the Elastic Properties window for the re-
gion.

2  Click in the Meter nominator field and type 
the correct number of beats per measure. For ex-
ample, if the region is in 3/4, type 3.

3  Click the Meter denominator field and type 
the correct note value. For example, if the meter 
is in 6/8, type 8.

Elastic Properties, selecting the Tempo Resolution



TCE Factor

The TCE Factor property displays the percentage 
of change applied to the source file. On tick-
based tracks, this property is display only and 
cannot be edited. On sample-based tracks, you 
can change the TCE Factor to apply TCE to the 
region. The percentage of the TCE factor is al-
ways calculated in relation to the source file.

Event Sensitivity

The Event Sensitivity property lets you filter 
Event markers based on the analysis confidence 
level. The confidence level for any detected 
transient event is based, in part, on the clarity of 
the transient. For example, if the file is a drum 
loop, loud accented hits will be analyzed with a 
higher degree of confidence than a soft, unac-
cented hit. 

The Event Sensitivity acts like a threshold for 
showing only the transient events that were de-
tected with a high degree of confidence. In 
Warp or Analysis track views you will see the 
number of Event markers decrease or increase as 
you lower or raise the Event Sensitivity. 

Lowering the event sensitivity can help reduce 
the number of erroneously detected transients. 
In turn, this can result in better sounding Elastic 
Audio processing. Pro Tools preserves the de-
tected transients when applying TCE in order to 
avoid flamming and granulation of the tran-
sients. Consequently, false transients are also 
preserved and the resulting sound quality can be 
less than desirable. If you are working with au-
dio material that does not have clearly defined 
transients, you may want to lower the Event 
Sensitivity in the Elastic Properties, or you may 
want to even edit the Event markers in Analysis 
view.
Input Gain

It is possible to encounter clipping when time 
compressing audio. Real-Time Elastic Audio 
plug-ins provide a Clip indicator to let you 
know when clipping has occurred. Rendered 
Elastic Audio regions display a Clip indicator on 
the region when clipping has occurred (see “Re-
gion Clip Indicator” on page 15).

If you encounter clipping when processing Elas-
tic Audio, use the Input Gain property to atten-
uate the gain of the audio signal before it is pro-
cessed.

AudioSuite Processing and 
Elastic Audio Regions
Real-Time Elastic Audio processing is non-de-
structive. However, since AudioSuite plug-ins 
process the entire region and write a new audio 
file (or actually apply destructive processing), 
when applying AudioSuite processing to regions 
on Elastic Audio–enabled tracks, any Elastic Au-
dio processing is rendered first, the rendered file 
is then processed by AudioSuite, and the result-
ing new audio file is analyzed for Elastic Audio 
processing. 

For REX files, Pro Tools converts the slices 
as Events with 100% confidence. Conse-
quently, setting the Event Sensitivity from 
99% to 1% does not filter out any events 
based on slices. However, if you set the 
Event Sensitivity to 0%, all markers are fil-
tered out regardless.
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Fades and Microfades

Fades and Elastic Audio Processing

When applying fades to warped regions (regions 
that have been processed by Elastic Audio), the 
audio selected for the fade is first rendered and 
then the fade is generated based on the rendered 
audio file. While you can create fades and cross-
fades on regions on Elastic Audio–enabled 
tracks, neither Real-Time nor Rendered Elastic 
Audio processing can be applied to fades. Con-
sequently, fades always retain their absolute du-
ration and fades must be recalculated after any 
Elastic Audio processing has been applied to the 
underlying audio. 

For example, if you change the session tempo, a 
region on a tick-based Elastic Audio–enabled 
track will change its duration (in minutes and 
seconds) to match the new tempo, but any fades 
that are part of that region do not change dura-
tion. The underlying audio is processed to 
match the tempo change, then it is rendered, 
and then the fade is regenerated. Even though 
the underlying audio changes, the absolute du-
ration of the fade does not.

In Warp view, you will notice that Event mark-
ers never appear in fades and that Warp markers 
cannot be added within fades. As a general rule, 
apply fades to regions on Elastic Audio–enabled 
tracks only after you have finshed any manual 
warp editing. 

Region groups that contain regions with 
fades are not allowed on Elastic Audio–en-
abled tracks.
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Microfades

Real-time Elastic Audio processing is not com-
pletely deterministic. Consequently, depending 
on where you start playback, the part of a region 
being played might actually be a few samples 
longer or shorter. When fades or crossfades are 
applied to warped regions, the audio waveform 
at the boundary between the (real-time) region 
and the (rendered) fade may not actually be 
continuous. 

For example, if there are two butt-spliced re-
gions on a Real-Time Elastic Audio–enabled 
track, Elastic Audio processes them separately 
even though they are contiguous on the track. 
As a result, the audio may not really be contigu-
ous after Elastic Audio processing and there may 
be an audible pop when playing back across the 
transition between the two regions. 

To help compensate, Pro Tools applies micro-
fades to region boundaries on Real Time Elastic 
Audio–enabled tracks. Microfades are small real-
time fades at region boundaries intended to mit-
igate artifacts across region boundaries, or be-
tween an Elastic Audio processed region and a 
rendered Fade file. Microfades are very short; 
they are only about 1.5 milliseconds long (64 
samples at 44 kHz, 128 samples at 96 kHz, and 
256 samples at 192 kHz).

Approximate Waveforms

Another consequence of Real Time Elastic Audio 
processing is that the drawing of the waveforms 
is only approximate. For example, if you bus 
record a Real Time Elastic Audio processed track, 
you will notice that the Waveform on the source 
track does not necessarily exactly match the re-
corded track. However, be assured that what you 
hear is an accurate rendition of the Real Time 
Elastic Audio processing even if the waveform 
drawing on the source track is only approxi-
mate.



Elastic Audio in DigiBase 
Browsers
DigiBase browsers provide several new com-
mands, controls, and indicators for previewing 
and importing Elastic Audio. You can batch an-
alyze audio files (AIFF or WAV), clear Elastic Au-
dio analysis, preview analyzed audio files at the 
session tempo, and even preview analyzed au-
dio files in time with the session during session 
playback.

New Elastic Audio Controls and 
Indicators

File Timebase and Elastic Audio Analysis Icons

With the addition of Elastic Audio, DigiBase 
browsers provide three new icons to indicate 
whether a file has Elastic Audio analysis and the 
file’s timebase.

Elastic Audio Analysis Icon Indicates that the file 
has Elastic Audio analysis data.

New controls and indicators in DigiBase browsers

Elastic Audio Analysis icon

Tick-based

Sample-based
file icon

Elastic Audio
Analysis icon

file icon

Audio Files Conform 
to Session Tempo

button
Elastic Audio

Plug-in selector
Sample-Based File Icon Indicates that the file is 
sample-based. The file’s duration is displayed in 
minutes and seconds.

Tick-Based File Icon Indicates that the file is 
tick-based. The file’s duration is displayed in 
Bars|Beats and the file’s native tempo is dis-
played in the tempo column.

Audio Files Conform To Session Tempo Button

When the Audio Files Conform to Session 
Tempo button is enabled, all tick-based audio 
files (those with tempo detected Elastic Audio 
analysis, as well as REX and ACID files), con-
form to match the session tempo. This lets you 
play back the session, and then simultaneously 
preview the selected files in time with the ses-
sion (see “Conforming Preview to the Session 
Tempo” on page 36).

Elastic Audio Plug-in Selector

The Elastic Audio Plug-in selector lets you select 
any Elastic Audio plug-in as the default plug-in 
for previewing and importing Elastic Audio. 
Only Real-Time Elastic Audio plug-ins are avail-
able.

Sample-based File icon

Tick-based File icon

Audio Files Conform to Session Tempo button

Elastic Audio Plug-in selector
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Elastic Audio Analysis in Browsers

You can both calculate and clear Elastic Audio 
analysis for selected audio files in DigiBase 
browsers. Only AIFF and WAV files are sup-
ported for Elastic Audio analysis and processing. 
Any other file format (such as MP3 and SD2) 
must be converted to AIFF or WAV for Elastic 
Audio analysis and processing.

To calculate Elastic Audio analysis:

1  In a browser, select the files you want to ana-
lyze.

2  Do one of the following:

• From the Browser menu, choose Calculate 
Elastic Analysis.

• Right-click one of the selected files and 
choose Calculate Elastic Analysis from the 
pop-up menu.

• Preview the file with the Audio Files Con-
form to Session Tempo option enabled.

Analyzed files are indicated by a check mark to 
the left of the file name. 

Analyzed files in which a regular tempo was de-
tected are updated as tick-based, display their 
duration in Bars|Beats, and display their native 
tempo in the Tempo column. 

Analyzed files in which no tempo was detected 
remain sample-based. These files typically con-
tain only a single transient (such as a snare hit) 
or they are longer files without a readily identi-
fiable regular tempo (such as entire songs).

Even though MP3 and SD2 file formats are 
not directly supported by Elastic Audio, you 
can import them into a WAV- or AIFF-
based session and then use the converted 
files on Elastic Audio–enabled tracks. File 
formats that do not match the session are 
converted automatically on import.
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To clear Elastic Audio analysis:

1  In a browser, select the files with Elastic Audio 
analysis that you want to clear.

2  Do one of the following:

• From the Browser menu, choose Clear Elas-
tic Analysis.

– or –

• Right-click one of the selected files and 
choose Clear Elastic Analysis from the pop-
up menu.

Files cleared of Elastic Audio analysis data revert 
to sample timebase, display their duration in 
minutes and seconds, and do not report a 
tempo.

Conforming Preview to the 
Session Tempo

Pro Tools lets you preview Elastic Audio ana-
lyzed files at the session tempo. The selected de-
fault Elastic Audio plug-in is used for previewing 
Elastic Audio analyzed audio files at the session 
tempo. Additionally, other tick-based files, such 
as REX and ACID files, can also be previewed at 
the session tempo and in time with playback. 

To preview files at the session tempo:

1  In the session, place the insertion point at the 
location where you want to preview the file in 
DigiBase.

2  In a DigiBase browser, select the file you want 
to preview.



3  Do one of the following:

• Click the Audio Files Conform to Session 
Tempo button. It highlights when enabled.

• From the Browser menu, select Audio Files 
Conform to Session Tempo.

• Right-click the file you want to preview and 
select Audio Files Conform to Session 
Tempo from the pop-up menu.

4  Click the Preview button in the browser and 
the file plays at the session tempo.

Preview in Context

Pro Tools lets you preview audio files in Digi-
Base browsers while playing back a Pro Tools 
session. Tick-based audio files (those with 
tempo detected Elastic Audio analysis, as well as 
REX and ACID files) can play back in tempo, 
and at the corresponding bar and beat location, 
with session playback. Tick-based audio files au-
dition at the session tempo when the Audio 
Files Conform to Session Tempo option is en-
abled. 

Deselect the Spacebar Toggles File Preview 
option in the Browser menu to be able to 
start and stop session playback with the 
spacebar without starting and stopping au-
ditioning in the browser. Use Control+P 
(Windows) or Command+P (Mac) to start 
and stop preview in the front-most browser 
during session playback. 
Elastic Audio on Import

When importing any audio file by drag and 
drop to an Elastic Audio–enabled track, the au-
dio file is imported and analyzed (if not already 
analyzed). If the imported audio file is tick-
based, it is conformed to tempo using the track’s 
Elastic Audio plug-in. If it is a sample-based au-
dio file, such as a single drum hit or short sound 
effect, it maintains its original duration. Longer 
audio files with no detectable tempo also re-
main sample-based.

When importing tick-based audio by drag and 
drop from DigiBase browsers to the Track List or 
empty space in the Edit window, Pro Tools cre-
ates a new tick-based, Elastic Audio–enabled 
track using the default Elastic Audio plug-in se-
lected in the Processing Preferences page (see 
“Elastic Audio Section” on page 45). 

Importing Elastic Audio from DigiBase 
to the Region List

With the Audio Files Conform to Session Tempo 
option enabled, dragging and dropping tick-
based audio from DigiBase browsers to the Re-
gion List (or to the Track List), creates two sepa-
rate regions in the Region List. The first is a sam-
ple-based whole file region and the second is the 
tick-based copy of the same region.

Importing REX and ACID Files

REX and ACID files are tick-based audio files and 
will be converted to the session file format on 
import. Dragging and dropping a REX or ACID 
file from DigiBase browsers to the Track List or 
empty space in the Edit window creates a new 
tick-based, Elastic Audio–enabled track using 
the Elastic Audio Default Plug-in. However, if 
the Import REX Files as Region Groups option is 
enabled in the Processing Preferences page, REX 
files are imported as tick-based region groups. 
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Elastic Audio in the Region 
List
Regions with Elastic Audio analysis (either resid-
ing on Elastic Audio–enabled tracks or imported 
with Elastic Audio analysis from DigiBase) can 
appear in the Region List as either tick-based or 
sample-based. Tick-based Elastic Audio regions 
will always have a corresponding sample-based 
whole-file region. Regions with Elastic Audio 
processing are identified with the Warp indica-
tor in the Region List. 

Previewing Elastic Audio in the Region 
List

Sample-based regions in the Region List always 
preview at their native tempo; no Elastic Audio 
processing is applied. Tick-based regions always 
preview at the session tempo. If a tick-based re-
gion’s native tempo is different from the session 
tempo, Elastic Audio processing is applied and a 
Warp indicator appears to the left of the region’s 
name in the Region List. The Warp indicator lets 
you know that Elastic Audio processing has 
been applied to the region.

Real Time Elastic Audio region in a track playlist and in 
the Region List

Warp indicator

Region Timebase indicator

Sample-based whole-file region
Tick-based region
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Importing Elastic Audio from the 
Region List

Dragging and dropping tick-based audio regions 
from the Region List to the Track List, or to 
empty space in Edit window, creates new Elastic 
Audio–enabled tick-based audio tracks using the 
selected default Elastic Audio plug-in (see “Elas-
tic Audio Section” on page 45).

Dragging and dropping tick-based or sample-
based audio regions from the Region List to ex-
isting tracks results in the same behavior as 
moving regions between tracks with different 
time bases and with or without Elastic Audio en-
abled (see “Moving Elastic Audio Between 
Tracks” on page 30).

Quantizing Audio
With Pro Tools 7.4, you can apply Quantize and 
Restore Performance to audio.

Quantizing Elastic Audio

Quantize can be applied to Event and Warp 
markers closest to the quantize grid on Elastic 
Audio–enabled tracks, whether they are sample- 
or tick-based. Event markers closest to the quan-
tize grid are promoted to Warp markers and all 
Warp markers closest to the quantize grid are 
quantized based on the Quantize settings.

Additionally, on all audio tracks, whether or not 
they are Elastic Audio–enabled, or sample- or 
tick-based, quantization can be applied to re-
gion start times or sync points. This lets you 
quickly quantize audio regions without apply-
ing TCE, and is especially useful when working 
with “one-shot” regions (single-event regions) 
such as sliced regions or region groups.



Use Restore Performance to undo quantization 
of audio and MIDI. See the Pro Tools Reference 
Guide for information on using Restore Perfor-
mance.

To quantize Elastic Audio events:

1  Select the audio you want to quantize on Elas-
tic Audio–enabled tracks. (Audio not on Elastic 
Audio–enabled tracks will not be quantized.)

2  Choose Events > Event Operations > Quan-
tize. 

3  In the Quantize window, select Elastic Audio 
Events from the What to Quantize pop-up 
menu.

4  Set the Quantize Grid and Options settings as 
desired.

5  Click Apply.

The Warp and Event markers closest to the 
Quantize Grid are quantized accordingly. TCE is 
applied between these markers and all other 
markers maintain their position relative to the 
Quantize Grid.

Selecting Elastic Audio Events for What to Quantize
Quantizing Audio Regions

Pro Tools lets you quantize audio region start 
times (or sync points) using the Quantize oper-
ation. Audio region start times (or sync points) 
are quantized to the nearest quantize grid value. 

To quantize audio regions:

1  Select the audio regions you want to quantize. 

2  Choose Events > Event Operations > Quan-
tize. 

3  In the Quantize window, select Audio Regions 
from the What to Quantize pop-up menu.

4  Set the Quantize Grid and Options settings as 
desired.

Quantized Elastic Audio Events in Warp view

Quantizing region groups only adjust the lo-
cation of the region group start (or sync 
point). To quantize the underlying sliced re-
gions in a region group, you must first un-
group, then quantize, and then regroup.

Before quantizing

After quantizing
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5  Click Apply.

The region start times (or sync points if present) 
are quantized according to the quantize set-
tings.

Quantizing Mixed Selections

You can apply Quantize to both MIDI notes and 
audio regions, or both MIDI notes and Elastic 
Audio events at the same time. However, you 
cannot apply Quantize to both audio regions 
and Elastic Audio events at the same time.

Quantized audio regions

Before quantizing

After quantizing
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4



chapter 3

Miscellaneous Pro Tools Features and 
Enhancements
Playback Engine 
Enhancements
The Playback Engine dialog includes the follow-
ing changes and new features:

Updated DAE Playback Buffer Size

In addition to levels, the DAE Playback Buffer 
Size shows values in milliseconds, which indi-
cates the amount of audio buffered when the 
system reads from disk. 

Playback Engine dialog (Structure plug-in not installed)
Chapter
Cache Size

The Cache Size determines the amount of mem-
ory DAE allocates to pre-buffer audio for play-
back and looping when using Elastic Audio. 

The optimum Cache Size for most sessions is 
Normal.

• A Cache Size setting of Minimum reduces the 
amount of system memory used for disk opera-
tions and frees up memory for other system 
tasks. However, performance when using Elastic 
Audio features may decrease.

• A Cache Size of Large improves performance 
when using Elastic Audio features, but it also de-
creases the amount of memory available for 
other system tasks, such as RTAS processing.

To change the Cache Size:

1  Choose Setup > Playback Engine.

2  From the Cache Size pop-up menu, select a 
disk cache size.

3  Click OK. 

Using a larger Cache Size leaves less system 
memory for other tasks. The default setting 
of Normal is recommended unless you are 
encountering -9500 (“Cache too small”) 
errors. 
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Plug-in Streaming Buffer Size

(Structure Plug-in Only)

This setting appears in the Playback Engine dia-
log only if the Structure Professional Sampling 
Workstation plug-in is installed on your system. 
The Plug-in Streaming Buffer Size determines 
the amount of memory DAE allocates for 
streaming playback from disk with the Structure 
plug-in. This setting only affects playback if disk 
streaming is activated in the plug-in controls.

The optimum Plug-in Streaming Buffer Size for 
most sessions is 250 ms (Level 2).

• Plug-in Streaming Buffer Size settings lower 
than 250 msec (Level 2) reduce the amount of 
system memory used for sample playback and 
frees up memory for other system tasks. How-
ever, reliability of sample playback may de-
crease.

• Plug-in Streaming Buffer Size settings higher 
than 250 msec (Level 2) improve the reliability 
of sample playback, but they also decrease the 
amount of memory available for other system 
tasks, such as RTAS processing.

Playback Engine dialog (Structure plug-in installed)
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
To change the Plug-in Streaming Buffer Size:

1  Choose Setup > Playback Engine.

2  From the Plug-in Streaming Buffer Size pop-up 
menu, select a buffer size.

3  Click OK. 

Optimizing the Plug-in Streaming Buffer 
Size

(Structure Plug-in Only)

This option appears in the Playback Engine dia-
log only if the Structure Professional Sampling 
Workstation plug-in is installed on your system. 
This option is useful when you are playing sam-
ples from the same drive that contains audio for 
the current session. When this option is se-
lected, Pro Tools automatically optimizes the 
size of the Plug-in Streaming Buffer to facilitate 
disk access from both Pro Tools and Structure. 
The Plug-in Streaming Buffer Size pop-up menu 
is unavailable when this option is selected.

To set Pro Tools to automatically optimize the 
Plug-in Streaming Buffer Size:

1  Choose Setup > Playback Engine.

2  Select the “Optimize for Streaming Content 
on Audio Drives” option.

3  Click OK. 

Using a larger Plug-in Streaming Buffer Size 
leaves less system memory for other tasks. 
The default setting of 250 ms (Level 2) is 
recommended unless you are experiencing 
problems with the reliability of streaming 
playback from disk.



System Usage Window 
Enhancements
In Pro Tools 7.4, the System Usage window up-
dates the CPU meter with two separate CPU 
meters: one for RTAS processing and one for 
Elastic Audio processing.

CPU (RTAS) Displays the amount of CPU pro-
cessing activity for RTAS processing.

CPU (Elastic) Displays the amount of processing 
activity for Real-Time Elastic Audio processing.

New and Improved 
Preferences Options

Display Preferences

Basics Section 

Language Options

Language Sets the language to use in the 
Pro Tools application, independently of what 
language version of Windows is used.

Default Automatic Naming to English Causes au-
tomatically named session elements in a session 
to be named in English even when working with 
the Pro Tools application set to another lan-
guage. This option is selected by default.

System Usage window (Pro Tools HD shown)

System activity meters
Chapter
Editing Preferences

Fades Section

REX Selects the default envelope shape for fades 
and crossfades between regions (“slices”) in im-
ported REX files. Fades are only applied to im-
ported REX files if the Import REX Files as Re-
gion Groups option and the Automatically 
Create Fades option are both enabled in the Pro-
cessing Preferences page. This option used to be 
named REX/ACID. ACID files are no longer im-
ported as region groups, but are imported as 
tick-based Elastic Audio.

REX Auto-Crossfades preference and dialog
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Zoom Toggle Section

In the Zoom Toggle section, the Track view op-
tion supports Warp/Notes, and the Zoom Toggle 
Follows Edit Selection option has been added.

Track View Selects Waveform/Notes, 
Warp/Notes, Last Used, or No Change for the 
Zoom Toggle Track View.

Zoom Toggle Follows Edit Selection When se-
lected, zoom toggle automatically follows the 
current edit selection. When disabled, changing 
the edit selection has no affect on the currently 
toggled-in track.

Processing Preferences

Import Section

Zoom Toggle preferences (Editing Preferences page)

Import preferences (Processing Preferences page)
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Import REX Files as Region Groups When se-
lected, REX flies are imported as region groups, 
all the underlying slices are imported as individ-
ual regions contained within the region group. 
When this option is not selected, importing 
REX files into a session converts them to the ses-
sion’s audio file format, the individual slices are 
consolidated, and the slice information is used 
for Elastic Audio analysis. These files remain 
tick-based after import and conversion. 

Automatically Create Fades When selected, 
crossfades are applied automatically to the 
sliced regions within region groups created by 
importing REX files. If the Import REX Files as 
Region Groups option is not selected, the Auto-
matically Create Fades option is not available. 

To change the default fade settings for REX files, 
click the REX button in the Default Fade Set-
tings section of the Editing Preferences page.

The Automatically Create Fades option used to 
be the Automatically Create Fades for Imported 
REX and ACID Files option located in the Edit-
ing Preferences page.

ACID files are always imported as tick-
based Elastic Audio if the Audio Files Con-
form to Session Tempo button is enabled in 
DigiBase or if REX and ACID Files Only or 
All Files is selected for the Drag and Drop 
from Desktop Conforms to Session Tempo 
preference.



Drag and Drop From Desktop Conforms to 
Session Tempo

The Drag and Drop From Desktop Conforms to 
Session Tempo options determine whether or 
not REX, ACID, and audio files are imported as 
tick-based Elastic Audio and conformed to the 
session tempo.

None When enabled, REX and ACID files, and 
all other audio files are not conformed to the 
session tempo when imported by drag and drop 
from Windows Explorer or the Mac Finder. They 
are imported as sample-based files and con-
verted to the sessions audio file format.

REX and ACID Files Only When enabled, only 
REX and ACID files are conformed to the session 
tempo when imported by drag and drop from 
Windows Explorer or the Mac Finder. REX files 
are imported either as tick-based Elastic Audio 
or, if the Import REX Files as Region Groups op-
tion is enabled, as tick-based region groups. 

All Files When enabled, all audio files are im-
ported as tick-based Elastic Audio and conform 
to the session tempo.

Elastic Audio Section

Pro Tools 7.4 provides three new Processing 
preferences for Elastic Audio. These preferences 
determine which Elastic Audio plug-in is used 
for preview and import, and whether or not new 
tracks are created with Elastic Audio enabled us-
ing the selected default plug-in.

Elastic Audio preferences (Processing Preferences 
page)
Chapter
Default Plug-in Lets you select any Real-Time 
Elastic Audio plug-in as the default plug-in for 
previewing and importing Elastic Audio. The se-
lected Default Elastic Audio plug-in is also used 
when new tracks are created with Elastic Audio 
enabled. The Elastic Audio Plug-in selector in 
DigiBase browsers inherits the selected Default 
Plug-in. Likewise, changing the selected plug-in 
in DigiBase browsers updates the selected De-
fault Plug-in in the Processing Preferences page.

Default Input Gain Lets you attenuate the signal 
input to Elastic Audio plug-ins by 0 to –6 dB for 
preview and import. If you experience clipping 
due to Elastic Audio processing during preview 
or after import, you may want to set the Default 
Input Gain to slightly attenuate the audio signal 
input for Elastic Audio processing. This prefer-
ence also applies to any audio imported to an 
Elastic Audio–enabled track.

If you commit any regions on a track (by dis-
abling Elastic Audio on the track) that were im-
ported with Input Gain, their region-based In 
put Gain is reset to 0.

The Elastic Properties window inherits the De-
fault Input Gain preference. To apply further re-
gion-based Input Gain for Elastic Audio process-
ing, select the region and adjust the Input Gain 
setting in the Elastic Properties window (see 
“Elastic Properties Window” on page 31).

Enable Elastic Audio on New Tracks When se-
lected, new tracks are created with Elastic Audio 
enabled. The selected Default Plug-in is used.

If the Enable Elastic Audio on New Tracks 
option is selected, you may want to also se-
lect the New Tracks Default to Tick Time-
base option in the Editing Preferences page.
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General Session and Track 
Features

Click Command Renamed 
Click/Countoff

The Click menu command has been renamed to 
Click/Countoff. 

Event Menu Commands Renamed

The following Event menu commands have 
been renamed for improved clarity:

The Time command is now called Time Opera-
tions. Its first submenu is now called Time Op-
eration Window (instead of Time Operations 
Window) and all of its windows are labeled as 
Time Operations. 

The Tempo command is now called Tempo Op-
erations. Its first submenu is now called Tempo 
Operations Window (instead of MIDI Opera-
tions Window) and all of its windows are la-
beled as Tempo Operations.

The MIDI Operations command is now called 
Event Operations. Its first submenu is now 
called Event Operations Window and all of its 
windows are labeled as Event Operations.

The Grid/Groove Quantize command and win-
dow have been renamed as Quantize.

Time Shift Plug-in Field Renamed

In the Time Shift plug-in window, the Time 
Shift field has been renamed to Speed.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Waveform Height Display 
Enhancements

In Pro Tools 7.4, the operation of the Zoomer 
tool has changed for vertical zooming of audio 
waveforms. 

� If you zoom an individual audio track (or 
group of tracks), the waveform display in that 
track remains offset when you zoom all tracks, 
unless you reset waveform height by doing any 
of the following:

• Double-click the Zoomer tool.

• Control-Shift-click (Windows) or Com-
mand-Shift-click (Mac) any of the Zoom 
buttons to set all audio track waveform 
heights to match the waveform height of 
the topmost audio track in the Edit win-
dow.

• Start-Shift-drag (Windows) or Control-
Shift-drag (Mac) in an audio track with the 
Zoomer tool to zoom all audio tracks.

� When you create a new track or import a track 
into a session, the waveform height of the new 
track will match the global waveform height 
(the waveform height of all tracks that are not 
individually zoomed). 

� When you duplicate a track, the new track 
will keep the waveform height of the original 
track. 



Vertical Zooming 

To continuously zoom vertically on a single audio 
track (or group of tracks):

� Start-drag (Windows) or Control-drag (Mac) 
with the Zoomer tool up or down in the track. 
The waveform height of the track will be offset 
from other audio tracks in the session.

To continuously zoom vertically on all audio 
tracks, do one of the following:

� Drag up or down on the Audio Zoom In but-
ton. Any waveform height offsets will be main-
tained.

– or –

� Start-Shift-drag (Windows) or Control-Shift-
drag (Mac) in an audio track with the Zoomer 
tool. All waveform height offsets will be lost.

To incrementally zoom vertically on all audio 
tracks, do one of the following:

� Click the Audio Vertical Zoom buttons. Any 
waveform height offsets will be maintained.

– or –

� Press Control+Alt+[ or Control+Alt+] (Win-
dows) or Command+Option+[ or Com-
mand+Option+] (Mac). Any waveform height 
offsets will be maintained.

To zoom all audio tracks and reset waveform 
display to the default height:

� Double-click the Zoomer tool. 

To set all audio track waveform heights to match 
the waveform height of the topmost audio track in 
the Edit window:

• Control-Shift-click (Windows) or Com-
mand-Shift-click (Mac) any of the Zoom 
buttons. All waveform height offsets will be 
lost.
Chapter
Save Session Updates
The Save Copy In dialog now includes options 
to Limit Character Set (see “Sharing Pro Tools 
7.4 Sessions” on page 54) and to not copy Elastic 
Audio Rendered Files.

Don’t Copy Elastic Audio Rendered Files

When this option is selected, Elastic Audio Ren-
dered files are not copied to the new session’s 
Rendered Files folder. 

Pro Tools opens the session with all available 
media, then shows you how many files are miss-
ing (if any) and asks how you want to proceed. 
You can choose to locate the existing render 
files, using Manually Find Relink or Automati-
cally Find Relink, or choose to Skip All to let 
Pro Tools recreate the rendered files from the 
session document. You can also select the “Re-
generate missing rendered files without search-
ing” option to exclude rendered files from the 
relink process and regenerate them instead.

Save Copy In dialog

Limit
Character 

Set 
option

Don’t Copy Elastic Audio Rendered Files option
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Importing Tempo From Tick-
Based Audio
If there are no tracks in the session, and you im-
port a tick-based audio file to the Region List, 
Track List, or the Timeline, you are prompted to 
either import the tempo from the file or use the 
default session tempo. To keep the default ses-
sion tempo, and have the loop conform to the 
session tempo, click Don’t Import. 

If the session already contains at least one track 
(regardless of track type), you are not prompted 
to import the tempo from the file and the file is 
conformed to the session tempo.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Missing Rendered Files
When opening a session with missing files, the 
Missing Files dialog opens. The Missing Files di-
alog now includes the option to Regenerate 
Missing Rendered Files Without Searching.

Regenerate Missing Rendered Files Without 
Searching

Enable this option to exclude Elastic Audio Ren-
dered files from the relinking process (rendered 
files are recalculated instead). This option is 
available when Automatically Find and Relink 
or Manually Find and Relink is enabled. 

Missing files warning when opening a session



DigiBase Enhancements
In Pro Tools 7.4, DigiBase browsers provide new 
audio preview commands, controls, and indica-
tors, as well as new Right-click functionality.

Browser Menu

The Browser menu adds three new commands 
for Elastic Audio analysis and preview: Calculate 
Elastic Analysis, Clear Elastic Analysis, and Au-
dio File Conform to Session Tempo.

New or enhanced controls in DigiBase browsers

You can also Right-click on any item in the 
Name column to access the commands in 
the Browser menu.

Preview
button

Volume
Meters

Audio Files
Conform to 

Browser
menu

Session Tempo 
button

Elastic Audio
Plug-in Selector
Chapter
Calculate Elastic Analysis Calculates Elastic Au-
dio analysis data for all selected audio files. An-
alyzed files are indicated by a check mark to the 
left of the file name. Analyzed files where a 
tempo has been detected are also updated as 
tick-based, display their duration in Bars|Beats, 
and display their native tempo in the Tempo 
column.

Clear Elastic Analysis Clears Elastic Audio analy-
sis data for all selected audio files. Files cleared 
of Elastic Audio analysis data revert to sample 
timebase, display their duration in minutes and 
seconds, and do not report a tempo.

Audio Files Conform to Session Tempo Con-
forms all tick-based audio files with Elastic Au-
dio analysis, as well as REX and ACID files, to 
the session tempo. This option lets you play 
back the session, and then simultaneously pre-
view the selected files in time with the session. 
This option is only available when a session is 
open, otherwise it is disabled and grayed out.

DigiBase Browser, Browser menu pop-up menu
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When the Audio Files Conform to Session 
Tempo option is enabled, Pro Tools analyzes un-
analyzed files on preview or import. Audio files 
that have been analyzed as tick-based can then 
be previewed at the session tempo and conform 
to the session tempo on import.

When the Audio Files Conform to Session 
Tempo option is disabled, any tick-based audio 
files with Elastic Audio analysis, and REX and 
ACID files preview and import at their native 
tempo. 

Preview Button

The Preview button starts and stops preview of 
audio files selected in browsers. You can also 
Right-click the Preview button to change the 
Preview mode and set whether or not the space-
bar toggles file preview. 

Loop Preview Mode Previews the selected file by 
looping playback of the file. If multiple files are 
selected, only the first selected file previews. 
When Loop Preview mode is enabled, the Pre-
view button updates to show a Loop Preview 
Mode icon.

For more information on working with 
Elastic Audio in DigiBase browsers, see 
“Elastic Audio in DigiBase Browsers” on 
page 35.

DigiBase Browser, Preview button Right-click pop-up 
menu

Start-click (Windows) or Control-click 
(Mac) the Preview button to toggle Loop 
Preview mode on and off.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Auto-Preview Enables or disables automatic pre-
view of files. When this option is enabled, se-
lecting a file in the browser starts preview. Addi-
tionally, the Preview button updates to show an 
Auto-Preview icon.

Spacebar Toggles File Preview Enables or dis-
ables the Spacebar for starting and stopping pre-
view. When this option is disabled, use the Pre-
view button to start and stop preview. In this 
mode, the spacebar starts and stops session play-
back. This lets you play back the session and, 
with the Audio Files Conform to Session Tempo 
option enabled, preview the selected audio file 
in time with the session.

Split Stereo Files Preview Together

When selecting one of a pair of Split Stereo files, 
such as “Drums.L” and “Drums.R,” both files 
preview together. To preview only the selected 
channel of a split stereo pair, press the Shift key 
and start preview.

Control-click (Windows) or Command-
click (Mac) the Preview button to toggle 
Auto-Preview mode on and off.

When a browser is front-most, Control+P 
(Windows) or Command+P (Mac) starts 
and stops preview. Also, the Esc key stops 
preview.



Volume

The new Volume control in DigiBase browsers 
lets you boost or attenuate the gain for preview-
ing selected files. 

To change the volume for previewing in DigiBase 
browsers:

1  Click the Volume field.

2  Adjust the resultant Volume fader as desired 
(from –INF to +12 dB).

Meters

The meters display the level of the audio and 
also provide clip indicators. For mono files, the 
mono signal is shown in both meters. For stereo 
files, the top and bottom meters show the left 
and right channels respectively. Greater than 
stereo multichannel files are displayed as 
summed mono in both meters.

The Clip LED lights when clipping occurs and 
clears automatically after 3 seconds.

Audio Files Conform To Session Tempo 
Button

The Audio Files Conform to Session Tempo but-
ton mirrors the corresponding Browser menu 
command. When enabled, all tick-based audio 
files with Elastic Audio analysis, as well as REX 
and ACID files, conform to the session tempo. 
This lets you play back the session, and then si-
multaneously preview the selected files in time 

DigiBase Browser, Preview Volume fader
Chapter
with the session. The Audio Files Conform to 
Session Tempo button is only available when a 
session is open, otherwise it is disabled and 
grayed out.

When the Audio Files Conform to Session 
Tempo button is enabled, Pro Tools analyzes 
any un-analyzed files on preview or import. 
Tick-based audio files conform to the session 
tempo during preview and on import. Sample-
based files, those where no tempo has been de-
tected, always preview and import at their orig-
inal speed and duration.

When the Audio Files Conform to Session 
Tempo button is disabled, any tick-based audio 
files with Elastic Audio analysis, and REX and 
ACID files preview at their native tempo. 

Elastic Audio Plug-in Selector

The Elastic Audio Plug-in selector lets you select 
any Elastic Audio plug-in as the default plug-in 
for previewing and importing Elastic Audio. 
Only Real-Time Elastic Audio plug-ins are avail-
able.

For more information on working with 
Elastic Audio in DigiBase browsers, see 
“Elastic Audio in DigiBase Browsers” on 
page 35.

Elastic Audio Plug-in selector
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File Timebase and Elastic Audio 
Analysis Icons

With the addition of Elastic Audio, DigiBase 
browsers provide three new icons to indicate 
whether a file has Elastic Audio analysis and the 
file’s timebase.

Elastic Audio Analysis Icon Indicates that the file 
has Elastic Audio analysis data.

Sample-Based File Icon Indicates that the file is 
sample-based. The file’s duration is displayed in 
minutes and seconds.

Tick-Based File Icon Indicates that the file is 
tick-based. The file’s duration is displayed in 
Bars|Beats and the file’s native tempo is dis-
played in the tempo column.

New timebase and analysis icons in DigiBase browsers

Elastic Audio Analysis icon

Sample-based File icon

Tick-based File icon

Tick-based

Sample-based
file icon

Elastic Audio
Analysis icon file icon
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Format Column Displays ReCycle and 
WAV (ACID)

The Format column now displays “ReCycle” for 
REX files and “WAV (ACID)” for ACID files. REX 
and ACID files are tick-based. 

Look Ahead Typing

DigiBase browsers now support “look ahead typ-
ing.” Type the first letter, or the first few letters, 
of the item you want to select in the browser. 
For example, if you have a folder full of drum 
loops, and the one you are looking for is named 
“Ska Loop,” just type the letters S and K on your 
computer keyboard and the first item that starts 
with “sk” will be highlighted in the list.

Language Compatibility 
Features

Unicode Support for Languages

Pro Tools 7.4 allows entry and display of any 
language characters supported in Unicode any-
where in the Pro Tools application. This lets 
you:

• Use multiple languages in session names, 
and in path names, file names and region 
names within the same session.

• Search for terms in multiple languages in 
DigiBase browsers. 

Pro Tools Application Language
(Windows Only)

You can choose the language you want to use in 
the Pro Tools application, independently of 
what language version of Windows you are us-
ing.



To select the language for Pro Tools:

1  Choose Preferences > Display.

2  Choose the language you want to use in 
Pro Tools from the Language pop-up menu.

Pro Tools Automatic Naming 
Language

When working in a language other than En-
glish, you can set Pro Tools to automatically 
name session elements (such as regions, tracks, 
and I/O paths) in English. This is useful when 
sharing sessions with other users working in En-
glish. 

Default Automatic Naming to English Causes au-
tomatically named session elements in a session 
to be named in English even when working with 
the Pro Tools application set to another lan-
guage. This option is selected by default.

To set the Automatic Naming Language to match 
the language selected for the Pro Tools 
application:

1  Choose Preferences > Display.

2  Choose the language you want to use in 
Pro Tools from the Language pop-up menu.

3  Deselect the “Default Automatic Naming to 
English” option.

Language options in the Display Preferences page
Chapter
Importing Session Data

Importing Session Data from Sessions 
Created with Pro Tools 7.4 

When importing data from sessions or OMF se-
quences created or saved with Pro Tools 7.4, 
Unicode data is preserved for the imported ele-
ments.

Importing Data from Sessions Created 
with Lower Versions of Pro Tools

When importing data from sessions or OMF se-
quences created or saved with versions of 
Pro Tools lower than 7.4, you need to identify 
the language encoding used in the imported el-
ements. 

To choose the language encoding when importing 
data from a legacy Pro Tools session:

1  Choose File > Import > Session Data.

2  Choose the language used in the legacy ses-
sion from the Text Encoding pop-up menu.

Text encoding options in the Import Session Data dialog
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Sharing Pro Tools 7.4 Sessions

When using the Save Copy In command to 
share sessions between systems, you can choose 
the language encoding used when saving the 
session materials. 

Sharing Pro Tools 7.4 Sessions with the 
Same Version of Pro Tools

When saving a copy of a session to the current 
session format, you can choose to limit the char-
acter set to a single language by selecting the 
Limit Character Set option.

Sharing Pro Tools 7.4 Sessions with 
Lower Versions of Pro Tools

When saving a copy of a session to a lower ses-
sion format, the Limit Character Set option is 
automatically selected.

To choose the language encoding when saving a 
copy of a session: 

1  Choose File > Save Copy In. 

2  Select the Limit Character Set option. 

3  Choose the language you want to use from the 
Limit Character Set pop-up menu. 

Limit Character Set pop-up menu in Save Copy In dialog
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Updating DigiBase Databases

In Pro Tools 7.3 and lower, DigiBase stored data-
base information in separate language folders 
for English, Japanese, Korean, Simplified Chi-
nese, and Traditional Chinese. 

In Pro Tools 7.4, DigiBase stores database infor-
mation for all languages in a single Unicode 
folder. 

Importing Databases Generated with 
Lower Versions of Pro Tools

When you connect a drive containing Digi-
design Databases generated with versions of 
Pro Tools lower than 7.4, Pro Tools converts the 
databases as follows:

If the databases include only one language 
folder, they are automatically imported to the 
Unicode folder.

If the databases include more than one language 
folder, only one of those language folders can be 
imported to the Unicode folder. When you first 
connect the drive to the system and launch 
Pro Tools, you will be prompted to choose the 
language to import.



Beat Detective Enhancement
Beat Detective includes the new analysis option, 
Enhanced Resolution, which is suitable for a 
wide range of audio material. Additionally, En-
hanced Resolution is now the default analysis 
option for Beat Detective. Because of the com-
plexity of the algorithm, Enhanced Resolution 
may take a little longer to analyze audio than 
the High Emphasis or Low Emphasis options.

For audio material in higher frequency ranges, 
the High Emphasis option may produce better 
results. For audio material in lower frequency 
ranges, Low Emphasis may produce better re-
sults. However, Enhanced Resolution is likely to 
produce the best results for the widest variety of 
audio material. 

Transient Resolution for Tabbing 
and Separating

Tab to Transients and the Separate Regions at 
Transients command both use the new En-
hanced Resolution transient detection algo-
rithm used in Beat Detective. This new algo-
rithm provides the best possible and most 
reliable transient detection for widest variety of 
audio material.

For regions on Elastic Audio–enabled tracks, Tab 
to Transients and Separate Regions at Transients 
use Elastic Audio Event markers.

Beat Detective window, Analysis pop-up menu
Chapter
Tab to Transients Command 
Keyboard Shortcut
With Pro Tools 7.4, you can use a keyboard 
shortcut to toggle the Tab to Transients com-
mand on and off.

To toggle the Tab to Transients command on and 
off:

� Press Control+Alt+Tab (Windows) or Com-
mand+Option+Tab (Mac).
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MIDI In with ReWire
Pro Tools 7.4 now supports receiving MIDI over ReWire. This lets you route the MIDI output from a 
ReWire client application (like Propellerhead’s Reason) to the MIDI input of a Pro Tools MIDI or In-
strument track (for a diagram of MIDI and audio signal flow with ReWire, see Figure 7 on page 56). 
This is especially useful for recording changes to parameters in a ReWire client application, such as 
Reason, to a Pro Tools MIDI track. You can then play back that track in Pro Tools to control the pa-
rameter changes in the ReWire client application.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Figure 7.  Audio and MIDI signal flow between Pro Tools and a ReWire client application (Reason shown)

Audio from ReWire client (Reason) to Pro  Tools

MIDI from Pro  Tools to ReWire client (Reason)

MIDI from ReWire client (Reason) to Pro  Tools



MIDI Automation with ReWire

You can use Pro Tools MIDI tracks to record 
MIDI continuous controller (CC) data from a 
ReWire client application, and then play back 
MIDI from Pro Tools to send the recorded MIDI 
CC data back to the ReWire client application. 
In this way, you can adjust parameters in the Re-
Wire client application (using the mouse or an 
external MIDI controller) and record those 
changes in Pro Tools. 

Recording MIDI Continuous Controller 
Data Over ReWire

The first step in automating a ReWire client ap-
plication’s parameters is to record the CC data 
to a MIDI track in Pro Tools.
Chapter
       

To record MIDI from a ReWire client application in 
Pro Tools:

 

1  

 

In Pro Tools, create a new MIDI track.

 

2  

 

From the track’s MIDI Input selector, select 
the ReWire device that you want to record.

 

3  

 

Record enable the MIDI track.

 4   Start recording in Pro Tools. 

5  

 

Switch to the ReWire client application.

 

Selecting the ReWire client device to record MIDI CC 
data in Pro Tools

 

You must select the ReWire device from 
which you want to record MIDI controller 
data. Leaving the track’s MIDI Input set to 
All does not record any MIDI data over Re-
Wire.
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6  Adjust the parameter for which you want to 
record MIDI CC data. Parameter changes are re-
corded to the Pro Tools MIDI track as CC data.

7  When you are done adjusting the parameter, 
return to Pro Tools and stop recording.

8  Record disable the MIDI track.

9  From the MIDI Track View selector in the Edit 
window, select the view for the CC data you just 
recorded.

Adjusting a parameter in a ReWire client application 
(Reason’s SubTractor shown)

If your external MIDI controller is correctly 
mapped to the corresponding ReWire client 
application’s parameters, and it is correctly 
routed through Pro Tools, use your MIDI 
controller to adjust the parameter you want 
to record.

MIDI CC data recorded from a ReWire client application
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
           

Playing Back MIDI Continuous 
Controller Data Over ReWire

 

Once you have recorded MIDI CC data from the 
ReWire client application to a MIDI track, con-
figure the MIDI track to play the ReWire client 
application. You can also edit the MIDI CC data 
in Pro Tools until you achieve the best results.

 

To play back MIDI CC data over ReWire:

 

1  

 

From the MIDI track’s MIDI Output selector, 
select the ReWire client application device you 
want to control (the same device from which 
you recorded the MIDI CC data).

 

2  

 

Start playback in Pro Tools.

 

3  

 

Switch to the ReWire client application. No-
tice that the corresponding parameter changes 
according the MIDI CC data from Pro Tools.

 

Pro Tools LE Hardware 
Support Enhancement

 

Footswitch Support for Playback 
Control and Punch In/Out Control

 

(003, 003 Rack, Digi 002, Digi 002 Rack, 
Mbox 2 Pro Only)

 

With Pro Tools 7.4, all Pro Tools LE interfaces 
with a footswitch jack can be set to control ei-
ther Playback Start/Stop or Recording 
Punch In/Out.

The default setting is Recording Punch In/Out. 
 

To set the footswitch control:

 

1  

 

Choose Setup > Hardware. 

 

2  

 

Select Record Punch In/Out or Playback 
Start/Stop.

   



chapter 4

Miscellaneous Pro Tools Video 
Enhancements and Features
  
Avid Mojo SDI Support for 
Pro Tools LE
(Pro Tools LE with 003 and Mbox 2 Only)

Avid Video Support

Pro Tools LE with an Avid Mojo SDI lets you im-
port, play back, and edit Avid video files in the 
Timeline.

For detailed information on workflows and con-
necting the Avid Mojo SDI to a Pro Tools sys-
tem, see the Avid Video Peripherals Guide and the 
Avid Mojo SDI Guide.

Check the compatibility pages of the Digi-
design website (www.digidesign.com) for 
the most current information for Avid Mojo 
SDI support with additional Pro Tools LE 
hardware.
Chapter 4: Mis
             

New Video Features Supported

 

Pro Tools LE with an Avid Mojo SDI supports 
the following video features that were previ-
ously supported only by Pro Tools HD and 
Pro Tools LE with DV Toolkit 2:

• Multiple video tracks in the Timeline

• Multiple QuickTime movies on an individ-
ual video track

• Multiple playlists for video tracks

• Multiple codecs on an individual video 
track

• Ability to drag video files from the Region 
List to the Timeline

• Gaps Between Regions option, for specify-
ing time between each imported video clip

• General video editing

• Video region groups

Pro Tools LE with an Avid video peripheral 
does not support digitizing video, the Video 
Universe window, or Windows Media 
(VC–1 AP) video.
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Multiple Video Tracks in the Timeline 

You can add multiple video tracks to the Time-
line, but only one video track can be played 
back at a time. 

Multiple QuickTime Movies on an 
Individual Video Track 

You can add multiple QuickTime movies to any 
individual video track. QuickTime video data 
appears in the Timeline as video regions.

Multiple Playlists for Video Tracks

Playlists provide an easy way of changing be-
tween alternate versions of a video track.

You can perform all of the same operations with 
video playlists as you can with audio playlists, 
including:

• Duplicating a playlist

• Assigning a playlist to another video track

• Renaming a playlist

• Deleting a playlist

Multiple Codecs on an Individual Video 
Track

A single video track can contain video regions 
compressed with different video codecs. How-
ever, once the first video file has been added to 
a session, all additional video files added to the 
Timeline must have the same video engine rate 
as the first video file. 

See the Pro Tools Reference Guide for de-
tailed information on playlists.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Video Track Type Icons

A video track displays a QuickTime or Avid icon 
depending on the type of video added to it. No 
icon displays when the video track is empty.

You can add any supported video to an empty 
video track, in which case the icon will update 
and the video track will play back only that type 
of video.

Dragging Video Files from the 
Region List to the Timeline

You can add Avid and QuickTime video files to 
the Timeline by dragging and dropping directly 
from the Region List to a video track.

To add video files to a video track by dragging 
them from the Region List:

1  Select one or more video files in the Region 
List.

2  In any Edit mode, drag the selected video files 
to a blank area in the Timeline (to create a new 
video track) or an existing video track (to place 
it within that track).

Video tracks displaying QuickTime and Avid icons

Avid 
icon

QuickTime 
icon



Gaps Between Regions Video 
Import Option

When you import more than one video clip into 
Pro Tools using the Video Import Options dia-
log, they are shuffled together by default. This 
option lets you indicate the number of seconds 
by which each video clip will be separated when 
imported into the video track.

See the Pro Tools Reference Guide for detailed in-
formation on importing video using the Video 
Import Options dialog.

Video Import Options dialog

Gaps
Between 
Regions
option
Chapter 4: Mis
General Video Editing

Most editing operations that are available for 
audio regions can also be applied to video re-
gions. This section describes all available video 
editing operations. Unless noted, the procedure 
for each video editing operation is the same as 
its audio editing counterpart.

Basic Video Editing Features

• Nondestructive editing

• Display of region names, region times, and 
other data in playlists

• Multiple video playlists

• Multiple Undo

• Video regions and video region groups in 
Region List

• All Edit modes

• All Edit Tools (except for Time Compres-
sion Expansion and Pencil tools)

Playing and Selecting Video Track Material

• Selecting within video frame boundaries (see 
“Selecting within Video Frame Boundaries” 
on page 63)

• Selecting and editing across multiple Video 
and audio tracks (see “Selecting and Editing 
Across Multiple Audio and Video Tracks” on 
page 62)

• Link or unlink track and Edit selections

• Auto-scroll video tracks

• Loop playback

See the Pro Tools Reference Guide for de-
tailed information on performing editing 
operations.
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Working with Regions and Selections

• Capture regions

• Separate regions and Separate Grabber Tool

• Region overlap and underlap

• All trimming commands except for TCE

• Heal separated regions

• Place, align, slide, shuffle, and spot regions

• Sync points

• Nudging

• Shift command

• Quantize region to Grid (rounds to nearest 
video frame)

• Replace Region command

• Cut, Copy, Paste, and Clear commands

• Special Cut, Copy, Paste, and Clear com-
mands:

• Repeat to fill selection

• Editing across multiple tracks

• Duplicate command

• Repeat command

• Region groups (see “Video Region Groups” on 
page 63)

• Region looping

Managing Regions

• Insert “silence” (see “Using the Insert Si-
lence Command to Insert Space in Video 
Tracks” on page 63)

• Compact Selected (nothing happens to the 
video, and at least one audio track must be 
selected)

• All naming and displaying of region com-
mands
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Editing Caveats

The following caveats apply to video editing in 
Pro Tools:

• MPEG-2 video can play back but cannot be 
edited.

• When creating and enabling a track group 
containing audio and video—and any au-
dio has region boundaries that do not line 
up with video frame boundaries— you can-
not tab through those region boundaries.

General Editing Operations Not 
Applicable to Video Regions

The following editing operations are applicable 
to audio regions, but are not applicable to video 
regions:

• Fades

• Mute/unmute regions

• AudioSuite plug-ins

• Waveform Repair with the Pencil tool

• Strip silence

• Consolidate regions

Selecting and Editing Across Multiple 
Audio and Video Tracks

You can create a selection across multiple audio 
and video tracks, and cut, copy, or paste audio 
and video simultaneously.

Audio and video that is selected and cut, copied, 
or pasted follow the current Edit mode.

Cutting across multiple track types (Slip mode shown)

Before After



Selecting within Video Frame 
Boundaries

Pro Tools does not let you select, play back, or 
edit a partial video frame. The following rules 
apply when selecting or editing video:

• When you make a selection in a video track, 
the selection boundaries follow the current 
Grid setting but round to the nearest video 
frame boundary, as follows:

• If the selection includes more than half of a 
video frame, the video frame is included 
within the selection.

• If the selection includes less than half of a 
video frame, it is not included in a video se-
lection.

• When you paste a selection containing video 
to a video track, the insertion point automat-
ically aligns with the closest video frame 
boundary.

When you paste audio and video simulta-
neously, this video frame re-alignment may 
result in the audio not being positioned ex-
actly where you placed it. A warning dialog 
displays when this occurs.
Chapter 4: Mis
Using the Insert Silence Command to 
Insert Space in Video Tracks

The Insert Silence command lets you insert 
space into a video track.

This command allows you to make a selection 
on a track (or tracks) and insert precisely that 
amount of space. You can also select across 
video and audio tracks, and use the Insert Si-
lence command to insert audio silence and 
space simultaneously.

In Shuffle mode, all video data on the track is 
shuffled later in the track by an amount equal to 
the selection. In Slip, Grid, or Spot mode, the In-
sert Silence command works just like the Edit > 
Clear command.

To insert space into a video track:

1  Make a selection in a track or tracks. The 
length of the selection determines the duration 
of the space inserted.

2  Choose Edit > Insert Silence.

Video Region Groups

You can include video regions within region 
groups for the following operations:

• Creating region groups

• Creating multitrack region groups (includ-
ing audio tracks)

• Editing region groups

• Creating fades and crossfades for audio files 
in region groups

• Importing and exporting region group files

See the Pro Tools Reference Guide for de-
tailed information on working with region 
groups.
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General Video-Related 
Improvements
Pro Tools 7.4 adds new support for general 
video-related improvements.

Expanded Video Resolution 
Support with Avid Mojo

Pro Tools with Avid Mojo includes expanded 
support for all video resolutions that were sup-
ported by previous versions of Pro Tools with 
AVoption|V10 or Pro Tools HD with 
Avid Mojo SDI, as follows:

• All standard-definition Avid OMF and MXF 
video files

• Avid IMX MPEG50, MPEG40, MPEG30, and 
OP1a files

• DV50, DV25 and DVC Pro 25 resolutions 
compressed with the Avid codec, including:

• DV25 411: DV25 interlaced scan at 4:1:1 
sampling (for NTSC 30i and PAL 25i 
projects)

• DV25 420: DV25 interlaced scan at 4:2:0 
sampling (for PAL 25i projects)

• DV25p 411: DV25 progressive scan at 4:1:1 
sampling (for NTSC 23.976p and NTSC 24p 
projects)

• DV25p 420: DV25 progressive scan at 4:2:0 
sampling (for PAL 25p and PAL 24p 
projects)

• All standard-definition Avid Multi-Cam 
Resolution files (see “Avid Multi-Cam Reso-
lution Files” on page 64.)

The oldest class of ABVB files (ABVB 
“MFM” files) are not supported in 
Pro Tools. These files were created with ver-
sions of Media Composer lower than 7.0, 
and do not have the .omf extension.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Avid Multi-Cam Resolution Files

Pro Tools with Avid Mojo adds support to all 
standard-definition Avid Multi-Cam Resolution 
files for import and playback. Pro Tools will play 
the clip of an Avid Multi-Cam Resolution file 
that was being used as the active camera angle 
when the file was exported to AAF or OMF.

Support for Co-Installation of Avid 
Xpress Pro 5.7.x with All 
Pro Tools 7.4 Platforms

Pro Tools 7.4 with Avid Mojo lets you install 
Avid Xpress Pro 5.7.x on the same computer. 

DigiTranslator Support on 
Pro Tools M-Powered Systems

Pro Tools M-Powered now supports the Digi-
Translator™ software option. DigiTranslator lets 
you convert and exchange OMF and AAF se-
quences and MXF files directly in the Pro Tools 
application. This option is purchased separately.

Support for Windows Media 
Video (VC-1 AP Codec) Files
(Windows Vista only)

Pro Tools natively supports the import and play-
back of Windows Media video files created using 
the VC-1 Advanced Profile codec. See your Win-
dows documentation for detailed information 
about Windows Media video.

Though not prohibited, editing Windows 
Media video or adding multiple clips to the 
timeline can lead to irregular video output 
performance.



Windows Media (VC-1 AP) Caveats

The following caveats apply to working with 
Windows Media (VC-1 AP) video in Pro Tools.

• Pro Tools cannot open Windows Media (VC-1 
AP) video files that require Windows Media 
File Digital Rights Management (DRM) pass-
words to view.

• High-resolution Windows Media (VC-1 AP) 
video plays back accurately at normal speed 
on the desktop or an external monitor with a 
qualified DirectShow output device. Due to 
processing requirements for VC-1 Advanced 
Profile decompression, Digidesign cannot 
guarantee accurate playback of video frames 
when performing other transport commands 
(such as scrubbing, looping, and off-speed 
play).

• Pro Tools does not support Windows Media 
(VC-1 AP) playback via Avid video peripher-
als.

Windows Media (VC-1 AP) Track 
Type Icons on Video Tracks

When you add one or more Windows Media 
(VC-1 AP) video files to an empty video track, it 
automatically displays a Windows Media icon. 
After Windows Media (VC-1 AP) video has been 
added to that track, it can only play back Win-
dows Media (VC-1 AP) video until all video has 
been removed from the track.

Video track displaying a Windows Media (VC-1 AP) icon

Windows 
Media (VC-1 
AP) icon
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Bouncing a Video Track with 
Windows Media (VC-1 AP) to a 
Windows Media (VC-1 AP) Movie

You can bounce the main video track and a 
mono or stereo mixdown of your session to a 
new Windows Media (VC-1 AP) movie.

You can choose from a variety of standard VC-1 
codecs, which are fully compatible with other 
VC-1 applications.

To bounce video and audio in the video track to a 
Windows Media (VC-1 AP) movie:

1  Finalize your mix.

2  Make sure the video track you want to bounce 
is currently the main video track. (The track’s 
Video Online button must be highlighted blue.)

3  Make sure that all of the audio tracks you want 
to include in the bounce are audible (not muted 
or inactive). 

4  Assign the output of each of the tracks you 
want to include in your bounce to the same ste-
reo output or bus path.

5  Do one of the following:

• To bounce the entire session, click Return 
to Zero in the Transport window to go to 
the beginning of the session. 

– or –

• To bounce a portion of the session, enable 
Options > Link Timeline and Edit Selec-
tion, and make a selection in the Edit win-
dow. 

QuickTime and Avid video cannot be 
bounced to Windows Media (VC-1 AP) 
video, and vice versa.

Because all formats and codecs have not 
been tested, you should verify the Windows 
Media (VC-1 AP) movie bounced success-
fully.
cellaneous Pro Tools Video Enhancements and Features 65



66
6  Choose File > Bounce to > Windows Media 
Movie.

The Bounce dialog appears.

7  Select your mix’s output or bus path from the 
Bounce Source selector.

8  Click Bounce.

9  In the VC-1 dialog, do the following:

• In the Profile pop-up menu, select the pro-
file matching the desired size and data rate 
of the exported movie—the larger the reso-
lution, the larger the resulting video file.

• To include uncompressed audio in the 
video file that will be exported, select Loss-
less Audio Compression.

10  Select a destination for the new Windows 
Media (VC-1 AP) movie, enter a new name, and 
click Save.

Bouncing video may take quite a bit longer than 
real-time, depending on the format of the 
source video, the format of the bounced video, 
and processing speed.
What’s New in Pro Tools LE and Pro Tools M-Powered 7.4
Support for Windows Media (VC-1 
AP) Playback on NTSC or PAL 
External Monitors

Pro Tools lets you output Windows Media (VC-1 
AP) video to NTSC or PAL monitors via any de-
vice that is compatible with standard Direct-
Show output. 

For a list of devices explicitly tested for Win-
dows Media (VC-1 AP) output from Pro Tools, 
see http://www.digidesign.com/support.

Compensating for Video Monitoring 
Delays with Windows Media (VC-1 AP) 
Video

You can compensate for delays in Windows Me-
dia (VC-1 AP) video output that may be intro-
duced by external decoders and certain types of 
displays.

To compensate for delays in Windows Media (VC-
1 AP) video caused by video monitoring devices:

1  Choose Setup > Video Sync Offset.

2  In the Windows Media Video Offset field, en-
ter a value appropriate to compensate for the de-
lay caused by your video monitor chain. When 
playing back Windows Media (VC-1 AP) video 
to the desktop, a setting of 0 (zero) is a good 
starting point. (Third party devices are available 
to help you measure this delay.) 

3  Click OK.
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